
PhotoFinish Help Contents

These are the main categories in the PhotoFinish help system. Choose a category to see a list of topics 
you can choose from.

To learn about PhotoFinish Help features, point to the picture of the key and press the left mouse button.

To learn more about using Windows on-line help, choose How to Use Help from the Help menu in the 
Help program.

Commands: Lists and explains the PhotoFinish menus.
For Beginners: Explains some basic PhotoFinish information.
Glossary Terms: Lists glossary terms used throughout the Help system.
Procedures: Lists topics you can choose to learn how to create, edit, view, and print pictures, use tools, 

scan, work with files, and work with colors.
Shortcuts: Explains shortcuts for choosing commands and selecting options.
Tools: Explains how to use the tools in PhotoFinish.
Utilities: Lists and gives a brief explanation of the utilities that are copied to your PhotoFinish directory 

during installation.
Update Info: This topic contains specific release information and other items that became available after 

the PhotoFinish manuals went to print.



Glossary Terms

Below is the list of glossary terms used in PhotoFinish. To read a definition, point to the word you want 
and press the left mouse button.

active picture window
background color
backup copy
cascading menu
check box
chrominance quantization
click
Clipboard
CMY
color selection box
color tolerance
command button
CONFIG.SYS
constrain
Control menu
control points
cutout
defined area
device independence
double-click
dpi
Draft mode
drag
drop-down list
frame markers
gradient
gray scale
grouped tools
halftone pattern
handles
HLS
icon
list box
luminance quantization
maximize
menu bar
mini-scroll bar
minimize
moiré pattern
option button
Palette
picas
picture window
pixels
points
posterize
press
primary color



printer halftone
Quality mode
retouch tools
RGB
scanner configuration file
Preview
secondary color
soft tools
temporary files
text box
thumbnail
tile pattern
title bar
Toolbox
virtual memory
Width & Shape workbox
work area



The Image Menu

You use the Image menu commands to enhance pictures, change the color format of pictures, flip, rotate, 
and resize pictures or cutouts, and to clear a picture to the background color. You use Filter commands to 
apply filters, Special Effect commands to apply special effects, and Tune commands to tune-up pictures 
or cutouts.

To choose an Image menu command, click Image and choose the command you want. Some commands 
are on cascading menus.

Image Menu Commands
AutoEnhance: Automatically improves the quality of a picture.
Filter Add Noise: Creates a textured effect in pictures or cutouts.
Filter Blend: Smoothes pictures or cutouts.
Filter Blur: Blurs pictures or cutouts.
Filter Diffuse: Scatters colors in pictures or cutouts.
Filter Maximum: Brightens blocks in pictures or cutouts.
Filter Minimum: Darkens blocks in pictures or cutouts.
Filter Posterize: Reduces the number of colors in pictures or cutouts.
Filter Remove Moiré: Eliminates unusual patterns that may occur during the scanning process in pictures 

or cutouts.
Filter Remove Spots: Erases spots and blotches in pictures or cutouts.
Filter Sharpen: Enhances detail in pictures or cutouts.
Special Effect Apply Texture: Applies a "textured" effect to pictures or cutouts.
Special Effect Black Hole: "Pulls" pictures or cutouts toward the center of the area.
Special Effect Crystallize: Changes blocks in pictures or cutouts to the most common color. The effect is 

similar to impressionistic paintings.
Special Effect Edge Detect: Enhances edges in pictures or cutouts.
Special Effect Emboss: Embosses pictures or cutouts.
Special Effect Facet: Changes blocks in pictures or cutouts to the middle color. 
Special Effect Fisheye Lens: Creates an effect similar to using a fisheye lens on a camera in pictures or 

cutouts.
Special Effect Mosaic: Creates a mosaic effect in pictures or cutouts.
Special Effect Motion Blur: Creates movement in pictures or cutouts.
Special Effect Outline: Outlines shapes in pictures or cutouts.
Special Effect Pixelate: Creates a block-like effect in pictures or cutouts.
Special Effect Twist: Rotates blocks in pictures or cutouts.
Tune Brightness and Contrast: Adjusts brightness and contrast in pictures or cutouts.
Tune Color/Gray Map: Adjusts color inaccuracies in pictures or cutouts.
Tune Equalize: Redistributes the shades of colors in pictures or cutouts.
Tune Hue and Saturation: Adjusts for color inaccuracies in pictures or cutouts.
Tune Negative: Reverses colors in pictures or cutouts.
Clear: Replaces the current picture with the selected background color.
Convert To: Converts pictures to another color mode.
Transform Flip Horizontal: Flips pictures or cutouts horizontally.



Transform Flip Vertical: Flips pictures or cutouts vertically.
Transform Rotate: Rotates pictures or cutouts by degrees.
Transform Free Resize: Resizes cutouts freehand.
Transform Resize: Resizes pictures or cutouts by a specified amount.
Info: Displays information about the picture.
Resolution: Changes the resolution of the picture.

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image AutoEnhance Command -- Improving the Quality of a Picture

To automatically correct your picture:    
1 Click Options to change the enhancements PhotoFinish applies to your picture.    

2 Choose Begin.    

3 Choose Accept to keep your changes.    

Related Topics:
Adjusting Brightness and Contrast
Changing Your Highlights and Shadows
Cropping Your Picture
Removing Moiré Patterns from Your Scanned Image



Changing Your AutoEnhance Options

To specify the auto enhancement options:

1 Click on the box next to the enhancement you want.    
2 Choose OK to use your new selections.

Related Topics:
Adjusting Brightness and Contrast
Changing Your Highlights and Shadows
Cropping Your Picture
Improving the Quality of a Picture
Removing Moiré Patterns from Your Scanned Image



Using Filter Commands

You use filters to enhance images and create special effects in pictures or cutouts. 

Filters are only one aspect of image enhancement. PhotoFinish also has tools and other commands you 
can use to edit your pictures.

Keep the following in mind when using filters:
All filters are available with gray scale or 24 bit color pictures. Diffuse and Remove Spots are 

available with 256 color pictures. Remove Spots is the only filter available with black and white pictures.

The Diffuse filter works best when your picture is 24 bit color or gray scale. You can 
convert your picture to one of these color modes.

Filters work fastest with a gray scale picture. Filters require more time with a 256 color 
picture than a 24 bit color picture.

If you change default filter settings, they are saved when you end your current 
PhotoFinish session.

If you need to return to PhotoFinish default settings, you can delete your PHOTO.INI file. 
Note that all of your program settings will return to program defaults, including any soft brush tool settings 
you have specified.

Preview allows you to view changes to your picture before they are made.

Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-
by-pixel.

Undo cancels everything you have done since the last time you chose a tool or 
command.

Related Topics:
Adding Texture to Your Picture
Applying the Maximum Filter
Applying the Minimum Filter
Blending with the Blend Filter
Blurring Your Picture
Cleaning Up a Scanned Image
Diffusing Your Picture
Posterizing Your Picture
Removing Moiré Patterns from Your Scanned Image
Sharpening with the Sharpen Filter
Using Special Effect Commands
Using Tune Commands
Working with Different Numbers of Colors



Image Filter Add Noise Command -- Adding Texture to Your Picture

To add texture to pictures or defined areas:    

1 Choose the type of effect you want.    

2 If you choose Custom, select the options you want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Blend Command -- Blending with the Blend Filter

To blend pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Custom Amount mini-scroll bar to specify the amount of blending you 

want.    

3 Choose OK.    

Related Topics:
Blending Freehand
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Blur Command -- Blurring Your Picture

To blur pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of blurring you 

want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Diffuse Command -- Diffusing Your Picture

To scatter colors in pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of diffusion you 

want.    
3 Choose Allow Color Shift to add new colors to a 24 bit color picture.

4 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Maximum Command -- Applying the Maximum Filter

To apply the Maximum filter to pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of effect you 

want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Minimum Command -- Applying the Minimum Filter

To apply the Minimum filter to pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of effect you 

want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Posterize Command -- Posterizing Your Picture

To apply the Posterize filter to pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the mini-scroll bar or type a number from 2 to 64 to specify the posterization 

you want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Remove Moiré Command -- Removing Moiré Patterns from Your 
Image

To remove moiré patterns in pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of patterns you 

want removed.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Remove Spots Command -- Cleaning Up a Scanned Image

To remove unwanted spots in pictures or defined areas:

1 Choose the spot size to remove.    

2 Choose OK.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Erasing Parts of Your Picture
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Sharpen Command -- Sharpening with the Sharpen Filter

To sharpen pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the mini-scroll bar or type a number from 1 to 100 to specify the amount of 

sharpening you want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Sharpening Freehand
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Using Tune Commands

You use the Tune commands to enhance images and tune-up pictures or cutouts.

The Tune commands are only one aspect of image enhancement. PhotoFinish also has tools and other 
commands you can use to edit your pictures.

Keep the following in mind when using Tune commands:

All Tune commands are available with 24 bit color pictures. All Tune commands except 
Hue and Saturation are available with gray scale and 256 color pictures. Negative is the only Tune 
command available for black and white pictures.

Tune commands work best when your picture is 24 bit color or gray scale. You can 
convert your picture to one of these color modes.

Tune commands work fastest with a gray scale picture. Tune commands require more 
time with a 256 color picture than a 24 bit color picture.

If you change default tune settings, they are saved when you end your current 
PhotoFinish session.

If you need to return to PhotoFinish default settings, you can delete your PHOTO.INI file. 
Note that all of your program settings will return to program defaults, including any soft brush settings you 
have specified.

Preview allows you to view changes to your picture before they are applied.

Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-
by-pixel.

Undo cancels everything you've done since the last time you chose a tool or command.

Related Topics:
Adjusting Brightness and Contrast
Adjusting Hue and Saturation
Changing Your Highlights and Shadows
Fine-Tuning with the Color/Gray Map
Inverting Colors in Your Picture
Using Filter Commands
Using Special Effect Commands
Working with Different Numbers of Colors



Image Tune Brightness and Contrast Command -- Adjusting Brightness and 
Contrast

To change brightness or contrast in pictures or defined areas:    

1 Drag the arrows or type numbers to adjust brightness and contrast.    

2 Choose OK.    

Related Topics:
Brightening Freehand
Changing Color Formats
Changing Contrast Freehand
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Tune Color/Gray Map Command -- Fine-tuning with the Color/Gray Map

To apply the Color/Gray Map command to pictures or defined areas:    
1 Select a Preset Maps option, and PhotoFinish automatically adjusts your picture.
2 Click Show Calibration Maps to include your calibration maps in the Preset Maps drop-down list.   

3 Select colors to change from the Channel drop-down list.    

4 Select a Style to make other changes.    

5 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Saving Response Curve Settings
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Tune Color/Gray Map Style Options

You can use several styles to get the response curve you want.

Curve

Freehand

Linear

This picture illustrates the color values represented in the response curve sample box:

Related Topics:
Fine-Tuning with the Color/Gray Map



Saving Response Curve Settings

To save response curve settings:
1 Type a name for the new color/gray map in the File Name text box.

2 Choose OK to save the map to disk.    

Related Topics:
Fine-Tuning with the Color/Gray Map



Image Tune Equalize Command -- Changing Your Highlights and Shadows

To equalize pictures or defined areas:    

1 Drag the arrows at the bottom of the bar graph to adjust the Low, Mid, and High values.    

2 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Fine-Tuning with the Color/Gray Map
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Tune Hue and Saturation Command -- Adjusting Hue and Saturation

To adjust hue and saturation in pictures or defined areas:    
1 Use the scroll bar or type a number in the Hue text box to specify how much the colors should shift 

around the color wheel.    
2 Use the scroll bar or type a number in the Saturation text box to specify the amount of hue you want to 

add or remove.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Tune Negative Command -- Inverting Colors in Your Picture

To invert the colors in pictures or defined areas:

Choose Tune Negative from the Image menu.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Replacing One Color with Another
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Using Special Effect Commands

You use the Special Effect commands to enhance images in pictures or cutouts. 

The Special Effect commands are only one aspect of image enhancement. PhotoFinish also has tools 
and other commands you can use to edit your pictures.

Keep the following in mind when using the Special Effect commands:

All Special Effect commands are available with gray scale or 24 bit color pictures. Black 
Hole, Crystallize, Fisheye Lens, Outline, Pixelate, and Twist are available with 256 color pictures. Outline 
is the only special effect command available with black and white pictures.

Special Effects work best when your picture is 24 bit color or gray scale. You can convert 
your picture to one of these color modes.

Special Effects work fastest with a gray scale picture. They require more time with a 256 
color picture than a 24 bit color picture.

If you change default Special Effect settings, they are saved when you end your current 
PhotoFinish session.

If you need to return to PhotoFinish default settings, you can delete your PHOTO.INI file. 
Note that all of your program settings will return to program defaults, including any soft brush tool settings 
you have specified.

Preview allows you to view changes to your picture before they are applied.

Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-
by-pixel.

Undo cancels everything you've done since the last time you chose a tool or command.

Related Topics:
Adding a Mosaic Effect to Your Picture
Adding Facets to Your Picture
Applying Texture
Applying the Black Hole Effect
Applying the Fisheye Effect
Creating a Motion Effect in Your Picture
Crystallizing Your Picture
Embossing Your Picture
Enhancing Edges
Outlining Shapes in Your Picture
Pixelating Your Picture
Twisting Your Picture
Using Filter Commands
Using Tune Commands
Working with Different Numbers of Colors



Image Special Effect Apply Texture Command -- Applying Texture

To apply a texture to pictures or defined areas:    

1 Click Load to select the picture to be used as a texture.    

2 Choose the type of effect you want.    
3 If you choose Custom, use the mini-scroll bar or type a number to specify the amount of texture you 

want.    
4 Click Invert Texture if you want to reverse the colors in the texture when it is applied.

5 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Loading a Texture from Disk

To load a previously saved texture:    

1 Select a File Type option.    

2 Select the drive and directory you want.    

3 Click a file in the File Name list box.    

4 Choose OK.    

Related Topics:
Applying Texture
Changing Color Formats



Image Special Effect Black Hole Command -- Applying the Black Hole Effect

To apply the Black Hole special effect to pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the mini-scroll bar or type a number from 1 to 100 to specify the amount you 

want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Crystallize Command -- Crystallizing Your Picture

To crystallize pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of crystallization 

you want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Edge Detect Command -- Enhancing Edges

To enhance edges in pictures or defined areas:    

1 Use the mini-scroll bar or type a number from 1 to 10 in the Sensitivity text box.    
2 Choose the color you want to fill the outlined areas from the Color drop-down list.

3 Choose a style for the color of the outline from the Edge drop-down list.    

4 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Outlining Shapes in Your Picture
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Emboss Command -- Embossing Your Picture

To emboss pictures or defined areas:    

1 Click a Direction button.    

2 Select a color from the Emboss Color drop-down list.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Facet Command -- Adding Facets to Your Picture 

To apply facets to pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to select a number from 1 to 6 to 

specify the amount of faceting you want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Fisheye Lens Command -- Applying the Fisheye Effect

To apply the Fisheye Lens special effect to pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the mini-scroll bar or type a number from 1 to 100 to specify the amount of 

fisheye lens effect you want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Mosaic Command -- Adding a Mosaic Effect to Your Picture

To apply the Mosaic special effect to pictures or defined areas:    

1 Choose the tile size to apply.    

2 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Motion Blur Command -- Creating a Motion Effect in Your 
Picture

To add a motion effect to pictures or defined areas:    

1 Click a Direction button.    
2 Use the mini-scroll bar or type a number from 1 to 50 in the Speed text box to specify the speed of the 

blur.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Outline Command -- Outlining Shapes in Your Picture

To outline shapes in pictures or defined areas: 
1 Select a background color for the non-outlined areas.
2 Choose Special Effect Outline from the Image menu.

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Enhancing Edges
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Pixelate Command -- Pixelating Your Picture

To create block-like effects in pictures or defined areas:    

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bars to specify the amount of pixelation you

want.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Twist Command -- Twisting Your Picture

To apply the Twist special effect to pictures or defined areas:    
1 Use the mini-scroll bars or type a number from 1 to 10 in the Size text box to specify the amount of the 

effect.    

2 Select an amount of rotation from the Angle drop-down list.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Clear Command -- Clearing Your Picture to the Background Color

To clear your picture to a new background color:

1 Select a background color.    
2 Choose Clear from the Image menu.

Related Topics:
Erasing Parts of Your Picture
Replacing One Color with Another
Restoring Your Previous Version
Undoing Changes to Your Picture



Image Convert To Command -- Changing Color Formats

To convert a picture to another color format:    
1 Choose Convert To from the Image menu.

2 Choose the option you want.    

Related Topics:
Working with Different Numbers of Colors



Convert To Options

Black and White

Gray Scale

256 Color

24 Bit Color



Image Transform Flip Horizontal Command -- Making a Mirror Image

To flip pictures or defined areas horizontally:

Choose Transform Flip Horizontal from the Image menu to make a mirror image.

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Turning Your Picture Upside Down



Image Transform Flip Vertical Command -- Turning Your Picture Upside Down

To flip pictures or defined areas vertically:

Choose Transform Flip Vertical from the Image menu to turn your picture upside down.

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Making a Mirror Image



Image Transform Rotate Command -- Rotating by Degrees

To rotate pictures or defined areas:

1 Choose the type of effect you want.    
2 If you choose Custom, use the Width and Height mini-scroll bar to specify the amount of custom rotation

you want.    

3 Choose OK.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area



Image Transform Free Resize Command -- Resizing Freehand

To freehand adjust a defined area:    

1 Define an area.    

2 Choose Free Resize from the Image menu.    

3 Drag a handle to stretch or shrink the picture.    
4 Choose a tool or click outside the marquee to paste the effect.

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Resizing Your Picture



Image Transform Resize Command -- Resizing Your Picture

To resize pictures or defined areas:    
1 Use the mini-scroll bar or type numbers in the Resize Width and Height text boxes to increase or 

decrease the size of the picture or defined area.    
2 Select a Units option from the Units drop-down list.
3 Choose OK to complete the command.

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Resizing Freehand



Info Command -- Displaying Picture Information 

To view information about a picture:

1 Read the information.    
2 Choose OK to return to your picture.

Related Topics:
Adjusting Picture Resolution
Displaying System Information



Resolution Command -- Adjusting Picture Resolution

To adjust the resolution of a picture:

1 Use the mini-scroll bars to adjust the resolution.    
2 Choose OK to return to your picture.

Related Topics:
Displaying Picture Information
Printing a Picture



The File Menu

You use File menu commands to start new pictures, load and save pictures, abandon changes, select 
your printer, change printer options, calibrate your printer, and exit PhotoFinish. The File menu may also 
contain commands to control TWAIN devices, as well as commands that control PhotoFinish pictures that 
are embedded or linked to other documents.

The File menu picture list displays the last four pictures you opened. As you open pictures, their names 
are added to the list. Click a picture name to open it.

To choose a File menu command, click File and choose the command.

File Menu Commands
New: Starts a new picture.
Open: Loads a picture previously saved to disk or stored on the clipboard.
Close: Closes the active picture and all its duplicates.
Save: Saves changes you make to a picture previously saved to disk.
Save As: Saves a new picture for the first time or saves a picture previously saved to disk with a new 

name or in a new format.
Revert: Abandons all changes since the last time you saved your picture.
Calibrate Printer: Calibrates your printer, and creates, edits, or deletes calibration maps.
Print: Prints the picture.
Print Setup: Selects the printer, printer halftone patterns, and printer options you use to print.
Viewer: Views pictures in thumbnail format. You can also manage your picture files with this command.
Exit: Closes the PhotoFinish program.
Acquire: Imports data from the selected TWAIN source. This command appears only if your scanner or 

video grabber supports the TWAIN standard interface.
Select Source: Selects which TWAIN source you use to scan. This command appears only if your 

scanner or video grabber supports the TWAIN standard interface.
Update: Updates the embedded object in the destination file without closing PhotoFinish. This command 

appears only if the current picture is an embedded object.
Save Copy As: Saves a copy of an embedded picture to a file on disk. This command appears only if you 

have linked or embedded an image. The embedded picture is not changed with this command.
Exit and Return To: Ends your PhotoFinish session and returns to the destination program. This 

command appears only if you have linked or embedded an image.



File New Command -- Starting a New Picture

To start a new picture:
1 Select a Units option.

2 Select a size for your picture in the Width and Height boxes.    

3 Select a color format from the Mode drop-down list.    
4 Choose OK.

Related Topics:
Opening an Existing Picture
Viewing Pictures
Working with Different Numbers of Colors
Working with Files



File Open Command -- Opening an Existing Picture

To open a previously saved picture:    

1 Select a File Type option.    

2 Select the drive and directory you want.    

3 Click a file in the File Name list box.    

4 Choose OK.    

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Previewing a Picture
Starting a New Picture
Viewing a Picture in Multiple Views
Viewing Pictures
Working with Different Numbers of Colors
Working with Files



Previewing a Picture

To preview a picture:

1 Read the displayed information.    

2 Click Show Thumbnail to see a small representation of the picture.    
3 Choose OK to return to the dialog box.

Related Topics:
Opening a Tile Pattern
Opening an Existing Picture
Pasting from Disk
Selecting Preferences
Working with Different Numbers of Colors



File Close Command -- Closing a Picture

To close a picture and all its duplicates:    
1 Choose Close from the File menu.
2 If you have made changes since the last time you saved, PhotoFinish asks if you want to save them.   

Related Topics:
Exiting PhotoFinish
Restoring Your Previous Version
Saving a Picture with a New Name
Saving a Picture with Save
The Control Menu
Viewing a Picture in Multiple Views



File Save Command -- Saving a Picture with Save

To resave a previously saved picture:    

Choose Save from the File menu.    

Related Topics:
Saving a Picture with a New Name
Updating an Embedded Picture



File Save As Command -- Saving a Picture with a New Name

To save a picture for the first time or to resave an existing picture:    

1 Select a File Type option.    

2 Select other available options from the File Sub-Format drop-down list.    

3 Select where you want to save the file.    
4 Type a name for the file.

5 Choose OK.    

Related Topics:
Compressing with JPEG
Copying Picture Files with the Viewer
Saving a Copy of an Embedded Picture
Saving a Picture with Save



Compressing with JPEG

To customize JPEG settings:    

1 If you are saving a 24 bit color picture, choose the Subsample you want.    
2 Use the Luminance Quantization mini-scroll bar or type a number to specify how much gray to lose.   

3 Use the Chrominance Quantization mini-scroll bar or type a number to specify how much color to lose.   

4 Choose OK to compress the picture.    

Related Topics:
Changing Color Formats
Saving a Copy of an Embedded Picture
Saving a Picture with a New Name
Working with 24 Bit Color Pictures
Working with Different Numbers of Colors
Working with Gray Scale Pictures



File Print Command -- Printing a Picture

To print a picture:    

1 Select a size for the printed picture.    

2 Select a unit of measure.    
3 Choose a number of copies to print.
4 Choose OK.

Related Topics:
Adjusting Picture Resolution
Calibrating your Printer
Printing
Setting Up Your Printer



File Print Setup Command -- Setting Up Your Printer

To set up your printer:
1 Select a printer from the Printer box.

2 Select a halftone option.    
3 Select an Orientation for your picture.

4 Click Options to change some of the printer options.    
5 Select a Paper Size and Source from the drop-down list.
6 Choose OK.

Related Topics:
Calibrating Your Devices
Calibrating Your Printer
Printing a Picture
Printing



File Calibrate Printer Command -- Calibrating Your Printer

To load a preset map:

1 Choose the map you want from the Preset Maps drop-down list.    
2 Choose OK to use the map.

3 You can choose Options to create a new map, recalibrate, edit, or delete the selected map.    

Related Topics:
Calibrating Your Devices
Printing a Picture
Printing



Recalibrating Your Printer

To recalibrate your printer:

1 Select which option you want your printer to be calibrated for, and choose OK.    

2 Place the picture that PhotoFinish printed on your scanner.    

3 Choose OK.    
4 Choose OK to save your changes to disk and use the new settings.

Related Topics:
Calibrating Your Devices
Creating a New Printer Calibration Map
Editing a Printer Calibration Map



Creating a New Printer Calibration Map

To create a new calibration map:
1 Choose a preset map that the new map is to be based on from the Based On drop-down list.
2 Type a name for the new calibration map in the File Name text box.

3 Choose OK to save the map to disk.    
4 Click Recalibrate to recalibrate your monitor and save it to the new map.
5 Click Edit to fine-tune the map.

Related Topics:
Calibrating Your Devices
Calibrating Your Printer
Printing



Editing a Printer Calibration Map

To edit a printer calibration map:    

1 Choose a channel to specify the colors to be adjusted.    

2 Adjust the curve to get the effect you want.    

3 Choose OK to save your changes to disk and use your new settings.    

Related Topics:
Calibrating Your Devices
Calibrating Your Printer
Creating a New Printer Calibration Map
Printing



File Revert Command -- Restoring Your Previous Version

To abandon all changes since the last time you saved your picture:    

Choose Revert from the File menu.    

Related Topics:
Clearing Your Picture to the Background Color
Deleting Portions of Your Picture
Erasing Parts of Your Picture
Undoing Changes to Your Picture
Undoing Some Changes



File Viewer Command -- Viewing Pictures

To view thumbnail pictures:    

1 Choose Browse to change the drive, directory, or image format.    

2 Click the picture you want to work with.    

3 Choose Open to load the selected pictures.    
4 You can also copy, move, rename, and delete selected pictures by clicking the corresponding button.

Related Topics:
Previewing a Picture
Working with Files



Browsing Through Thumbnails

To browse through thumbnails:

1 Choose the file types that you want displayed.    
2 Choose OK to view thumbnails in the new drive, directory, or format.

Related Topics:
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Moving Picture Files with the Viewer
Previewing a Picture
Renaming Picture Files with the Viewer
Viewing Pictures
Working with Files



Copying Picture Files with the Viewer

To copy picture files:    

1 Choose where you want the selected file to be copied.    
2 Choose OK to copy the files.

Related Topics:
Browsing Through Thumbnails
Deleting Picture Files with the Viewer
Moving Picture Files with the Viewer
Previewing a Picture
Renaming Picture Files with the Viewer
Viewing Pictures
Working with Files



Moving Picture Files with the Viewer

To move picture files:    

1 Choose where you want the selected file to be moved.    
2 Choose OK to move the files.

Related Topics:
Browsing Through Thumbnails
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Previewing a Picture
Renaming Picture Files with the Viewer
Viewing Pictures
Working with Files



Deleting Picture Files with the Viewer

To delete picture files:    

Choose OK to delete the files.

Related Topics:
Browsing Through Thumbnails
Copying Picture Files with the Viewer
Moving Picture Files with the Viewer
Previewing a Picture
Renaming Picture Files with the Viewer
Viewing Pictures
Working with Files



Renaming Picture Files with the Viewer

To rename picture files:    
1 Type the new name for the selected picture in the File Name text box.
2 Choose OK to rename the file.

Related Topics:
Browsing Through Thumbnails
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Moving Picture Files with the Viewer
Previewing a Picture
Viewing Pictures
Working with Files



File Exit Command -- Exiting PhotoFinish

To end your PhotoFinish session:

If you have made changes to a picture since the last time you saved, PhotoFinish asks if 
you want to save them.    

Related Topics:
Closing a Picture
Exiting and Returning to the Destination Application



The Edit Menu

You use Edit menu commands to correct mistakes, copy or cut to the Clipboard or to disk, paste from the 
Clipboard or disk, crop a selected area, and otherwise manipulate your picture.

To choose an Edit menu command, click Edit and choose the command.

Edit Menu Commands
Undo: Cancels changes made since the last time you chose a tool or command.
Cut: Deletes a defined area and copies it to the Clipboard.
Copy: Copies a defined area to the Clipboard.
Paste: Places the contents of the Clipboard, surrounded by the marquee, in the upper left corner of the 

screen.
Delete: Deletes a defined area without copying it to the Clipboard.
Copy To: Copies a defined area to disk.
Paste From: Places a picture saved to disk, surrounded by the marquee, in the upper left corner of the 

screen.
Crop: Copies a defined area to a new picture.
Select All: Selects your entire image.
Select None: Pastes a cutout or cancels your current selection.
Select Leave Original: Leaves a single copy of the cutout behind when you move it.
Select Transparent: Makes the background color of a cutout transparent.



Edit Undo Command -- Undoing Changes to Your Picture

To cancel recent changes:    

Choose Undo from the Edit menu.

Related Topics:
Clearing Your Picture to the Background Color
Cutting to the Clipboard
Deleting Portions of Your Picture
Erasing Parts of Your Picture
Restoring Your Previous Version
Undoing Some Changes



Edit Cut Command -- Cutting to the Clipboard

To cut a defined area to the Clipboard:    
1 Select a background color to fill the cut area.

2 Define an area.    

3 Choose Cut from the Edit menu.    

Related Topics:
Copying to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Deleting Portions of Your Picture
Pasting from the Clipboard
Undoing Changes to Your Picture



Edit Copy Command -- Copying to the Clipboard

To copy a defined area to the Clipboard:    

1 Define an area.    
2 Choose Copy from the Edit menu.

Related Topics:
Copying Picture Files with the Viewer
Cutting to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Pasting from the Clipboard
Saving Portions of Your Picture to Disk



Edit Paste Command -- Pasting from the Clipboard

To paste a cutout from the Clipboard:    

1 Choose Paste from the Edit menu.    

2 Drag the cutout to move it to another area.    
3 Choose a tool, click outside the marquee, or choose Select None to paste the cutout.

Related Topics:
Copying to the Clipboard
Cutting to the Clipboard
Loading a Palette
Manipulating Defined Areas
Pasting from Disk



Edit Delete Command -- Deleting Portions of Your Picture

To delete a defined area from your picture:    
1 Select a background color to fill the cut area.

2 Define an area.    

3 Choose Delete from the Edit menu.    

Related Topics:
Cropping Your Picture
Cutting to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Erasing Parts of Your Picture
Undoing Changes to Your Picture



Edit Copy To Command -- Saving Portions of Your Picture to Disk

To copy a defined area to a file:

1 Select a File Type option.    

2 Select other available options from the File Sub-Format drop-down list if they are available.    

3 Select where you want to save the file.    
4 Type a name for the file.

5 Choose OK.    

Related Topics:
Copying Pictures Files with the Viewer
Copying to the Clipboard
Cropping Your Picture
Cutting to the Clipboard
Pasting from Disk
Pasting from the Clipboard
Saving a Picture with a New Name



Edit Paste From Command -- Pasting from Disk

To paste an image from a file:    

1 Select a File Type option.    

2 Select the drive and directory you want.    

3 Click a file in the File Name list box.    

4 Choose OK.    

5 Drag the cutout to move it to another area.    
6 Choose a tool, click outside the marquee, or choose Select None to paste the cutout.

Related Topics:
Making the Background Color Transparent
Manipulating Defined Areas
Pasting from the Clipboard
Previewing a Picture
Saving Portions of Your Picture to Disk
Viewing Pictures



Edit Crop Command -- Cropping Your Picture

To crop a portion of your picture:

1 Define an area.    
2 If you are selecting a non-rectangular area, select a background color for the area surrounding the 
cutout in the rectangular window.

3 Choose Crop from the Edit menu.    
4 Use the Save As command to save the cropped picture to disk.

Related Topics:
Copying to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Deleting Portions of Your Picture
Making the Background Color Transparent
Quickly Pasting a Cutout or Canceling Current Selections



Edit Select All Command -- Selecting Your Entire Picture

To select your entire picture:    

Choose Select All from the Edit menu.    

Related Topics:
Copying to the Clipboard
Deleting Portions of Your Picture
Pasting from the Clipboard
Quickly Pasting a Cutout or Canceling Current Selections



Edit Select None Command -- Quickly Pasting a Cutout or Canceling Current 
Selection

To quickly paste a cutout or cancel your current selection:    

Choose Select None from the Edit menu.

Related Topics:
Deleting Portions of Your Picture
Undoing Changes to Your Picture



Edit Select Leave Original Command -- Leaving a Copy of a Cutout

To leave a copy of a cutout behind:

1 Define an area.    

2 Choose Select Leave Original from the Edit menu.    

3 Drag the cutout to another location.    

4 Choose the command again to turn off Select Leave Original.    

Related Topics:
Copying to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Deleting Portions of Your Picture
Making the Background Color Transparent
Quickly Pasting a Cutout or Canceling Current Selections



Edit Select Transparent Command -- Making the Background Color Transparent

To make the background color of a cutout transparent:

1 Choose the cutout you want to paste into your picture.    

2 Choose a background color.    

3 Choose Select Transparent from the Edit menu.    

4 Drag the cutout to another location.    
5 Choose another tool or choose Select None to paste the cutout.

6 Choose the command again to turn off Select Transparent.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Leaving a Copy Behind
Manipulating Defined Areas
Pasting from Disk



active picture window
The picture window you are working on. Its title bar is shaded differently from other open windows. To make a window active, click 
its title bar or choose another picture from the Window menu list.



background color
Many tools and commands use the background color. To change your background color, point in the Palette to the color you want, 
hold down Shift and click the left mouse button. You can also select the Eyedropper tool, point to a color in your picture, hold down 
Shift, and click the left mouse button. The new background color appears in the color selection box on the left of the Palette. Double-
click the Eraser or use Image Clear to clear a picture window to the background color.



backup copy
Choose the Save Backup Copy option when you use the Save As or Copy To command to keep a backup of your picture as it was 
when you last chose Save or Save As. The backup file's name is the same as the original's, except the last letter of the extension is 
a $. For example, the backup file of GRAPH.PCX is GRAPH.PC$.



cascading menu
A command with an arrow to the right of it contains a cascading menu. To choose a command on a cascading menu, click a 
command with an arrow. When the cascading menu appears, choose a command.



check box
Found in dialog boxes. Click a box to select it. A selected check box contains an X. Click the box again to unselect it. Unavailable 
choices are dimmed.



chrominance quantization
Used in the Custom JPEG compression. Specifies how much color to lose in a group of pixels. The number selected for the size of 
the groups of pixels with Subsample determines the level at which PhotoFinish compresses the colors in specified blocks. This 
procedure makes the picture file smaller which aids in transmission and saves disk space. 



click
Point to the area or tool you want, press the mouse button and release it in one smooth, quick motion. Unless otherwise noted, click 
the left mouse button.



Clipboard
The clipboard stores graphics or text you cut or copy until you cut or copy again. Use Paste to insert graphics from the clipboard into
your active picture. To insert text from the clipboard, select the Text tool. When the Enter Text dialog box appears, press Shift+Ins.



CMY
Cyan-magenta-yellow. A way to refer to colors by their amount of cyan, magenta, and yellow. The CMY values range from 0 to 255, 
where 0 is the minimum amount of a particular color and 255 is the maximum amount. See also HLS and RGB.



color selection box 

The box on the left of the Palette that displays current primary, secondary, and background colors, tool settings, gradient effect, or 
the loaded tile pattern. Only the color selection box shows in a folded Palette.



color tolerance
The range of colors PhotoFinish looks at to determine how much of the picture to fill with any paint roller tool, replace with the Color 
Replacer tool, or select with the Magic Wand tool. The larger the range of numbers, the larger the range of colors that are affected 
when you use one of the appropriate tools.



command button 
A button in a dialog box that initiates action. For example, OK applies your settings and Help activates the help program. Command 
buttons followed by an ellipsis (...) bring up other related dialog boxes.



CONFIG.SYS
The CONFIG.SYS file tells your computer what types of devices, such as scanners, are installed in your computer system. The 
CONFIG.SYS file must be in the root directory of your boot disk or hard drive. The PhotoFinish Setup Program can automatically 
make CONFIG.SYS changes when you install a scanner.



constrain
Use the Shift key with many tools to force the tool to paint in a particular direction or shape. You can constrain the box tools, 
including the Box Selection tool, to a square. You can constrain the Ellipse/Circle tools, including the Elliptical Selection, to a circle. 
You can constrain other tools vertically, horizontally, or at a 45-degree angle. Press the spacebar to change between vertical and 
horizontal constraint.



Control menu 
Click on the box containing a hyphen or dash on the left side of a window's title bar to open its Control menu. To open the Control 
menu of a minimized window, click on the icon. To quickly close or hide a window or workbox, double-click the Control menu box.



control points
Squares or circles on the gadget box, text frame box, and curve which you use to manipulate an area of your picture, the margins of 
text, or the shape of a curve.



crop
An area of a picture defined with the Scissors, Box Selection, Lasso, Elliptical Selection, or Magic Wand tool that is copied into a 
new picture window.



cutout
An area of a picture defined with the Scissors, Box Selection, Lasso, Elliptical Selection, or Magic Wand. A cutout is surrounded by 
the marquee. Use Edit menu commands to cut, copy, and paste cutouts. Use Image menu commands to flip, resize, and apply the 
Filter, Tune, and Special Effect commands to cutouts.



defined area
A defined area is a part of a picture that is surrounded by the gadget box and marquee. Use the Scissors, Box Selection, Lasso, 
Elliptical Selection, or Magic Wand to define an area. Areas you paste are also defined areas.



device independence
PhotoFinish allows you to load and edit images that have more colors than your hardware supports while retaining all of the original 
details and colors in your picture. PhotoFinish simulates the colors and shades not supported by your monitor.



double-click
Point to the area or tool you want, quickly press the mouse button twice and release it. Unless otherwise noted, double-click the left 
mouse button.



dpi
Dots per inch. Printers and Scanners produce a designated ratio of dots per inch. A higher dpi produces a sharper image that 
appears larger on screen and requires more storage space.



Draft mode
Prescan mode. Draft mode scans more quickly than Quality mode, at the lowest possible resolution with the lowest number of colors
possible for the scanner (usually black and white). Use Draft mode to see an approximation of the final scan.



drag
Press the mouse button, and hold it down while you move or drag the mouse. Unless otherwise noted, press the left mouse button.



drop-down list
List that drops down from a display box to show the current selection. To open a list, click the underlined arrow. Use the scroll bar to 
move up and down in the list.



frame markers
Small squares on the frame in the Scan Area dialog box, that resize the scan area.



gradient

Gradients can be vertical , horizontal

, or radial

. They are shaded from secondary to background color. You can fill an area with a gradient. Use Options Gradient Type to 
change the look and brightness of a gradient.



gray scale
Solid colors of gray. PhotoFinish supports gray scale pictures. Keep in mind that since PhotoFinish has device independence, grays 
that appear halftoned on-screen, retain their true colors.



grouped tools    

Similar tools that are grouped together to reduce the size of the Toolbox. A triangle appears in the bottom right corner of the 
displayed tool. To select another tool within a group, press the triangle. When the available tools appear, drag to the tool you want, 
and release the mouse button. The new tool appears in the Toolbox.

To show the tools ungrouped, choose the Layout Ungroup command from the Toolbox Control menu.



halftone pattern
A series of dots that simulate a color. A series of dots that PhotoFinish applies to build a gradient to covert a picture to fewer colors 
or when your picture contains more colors than your printer or monitor supports. Choose Optimize Display from the Display menu to 
change the halftone pattern PhotoFinish uses to display pictures.



handles
Squares or circles on the gadget box, text frame box, and curve tool you use to manipulate a cutout, margins of text, or a shape's 
curve.



HLS
Hue-lightness-saturation. A way to refer to colors by their amount of lightness and saturation and their hue. The hue is the spectrum 
arranged in a circle where red is 0, yellow is 60, green is 120, cyan is 180, blue is 240, magenta is 300 and red is 360, again. 
Lightness and saturation are values ranging from 0.0 to 1.0. See also CMY and RGB.



icon
The small picture representation of a minimized window. Click the down arrow to the right of a window's title bar to minimize it. 
Double-click an icon to open the window on your screen.



list box
Box in a dialog box that shows available selections, such as a file list box. Use the scroll bar to move up and down in the list. To 
select an item, click it and choose a command button. Double-click your selection to choose it and complete the command.



luminance quantization
Used in the Custom JPEG compression. Specifies how much gray to lose in a group of pixels. The number selected for the size of 
the groups of pixels with Subsample determines the level at which PhotoFinish compresses the grays in specified blocks. This 
procedure makes the picture file smaller which aids in transmission and saves disk space. 



maximize 
You can maximize a PhotoFinish picture and the PhotoFinish desktop to the size of your screen by clicking the up arrow on the right 
corner of the title bar. To edit in Full Screen view, click the double arrow on the right corner of the status bar. To maximize a window 
that has been shrunk to an icon, double-click the icon, or click the icon and choose Maximize from the Control menu. You cannot 
maximize the Palette, Toolbox, or Width & Shape workbox.



menu bar
The horizontal bar below the program title bar that contains menu names. Each menu contains a list of commands you can choose.



minimize 
You can minimize or shrink a picture window and the PhotoFinish desktop to an icon by clicking the down arrow on the right corner 
of the title bar. You cannot minimize the Palette, Toolbox, or Width & Shape workbox.



mini-scroll bar    
Adjusts numerical values. Mini-scroll bars can be vertical or horizontal. Click the arrows to increase or decrease values by single 
increments. To quickly adjust the values, point to the box between the arrows. When your pointer is a double-sided arrow with lines 
through the center, drag the mouse to change the value. You can also type numbers in the text box to adjust numerical values.



moiré pattern
An irregular pattern that may appear in a scanned image.



option button
A button that allows you to choose one of several items. Click a button to select it. A selected button contains a filled dot. 
Unavailable choices are dimmed or do not appear.



Palette 
Workbox you display to view and change colors or tool settings. Choose Screen Layout Palette the Display menu, or press Ctrl+P to
display or remove your Palette.

The color selection box is on the left side of the Palette, and shows the selected setting value or the selected primary, secondary, 
and background colors. The rest of the Palette shows available colors or settings for the current tool. Each picture has its own 
palette. The palette of a 24 bit picture shows 256 of the available 16.7 million colors.

Use Save Palette As to save the current set of colors to disk in a palette you can load into another picture.



picas
Unit of measurement. There are six picas in one inch and twelve points in one pica.



picture window
Each picture is loaded into its own picture window. You can open up to 8 pictures. You can duplicate windows until you have 20 
windows displayed. Each open window increases the memory your system requires.



pixels
Unit of measurement. Individual dots on a screen or a printer.



points
Unit of measurement. There are twelve points in one pica and six picas in one inch.



posterize
An effect that decreases the number of colors in your entire picture or in a defined area. This is useful if you want to create sharp 
contrasts between areas of your picture. 



press
Hold down the mouse button. Unless otherwise noted, press the left mouse button.



primary color
Many tools and commands use the primary color. To change your primary color, point in the Palette to the color you want and click 
the left mouse button. You can also select the Eyedropper tool, point to a color in your picture, and click the left mouse button. The 
new primary color appears in the color selection box on the left of the Palette .



printer halftone
Pattern of dots that simulates a color, used when you print a picture that has more colors than your printer supports.



Quality mode
Prescan mode. Quality mode scans in the lowest possible resolution and at the lowest number of colors possible for the Image Type
you select with the Scanner Setup options. Quality mode takes more time than Draft mode but provides a better representation of 
the final scan.



RGB
Red-green-blue. A way to refer to colors by their amount of red, green, and blue. The RGB values range from 0 to 255, where 0 is 
the minimum amount of a particular color and 255 is the maximum amount of a particular color. See also CMY and HLS.



retouch tools
Tools you use to add coloring and shading effects. The retouch tools are the contrast, brighten, tint, blend, smear, smudge, and 
sharpen tools. You can also use Filter, Tune, and Special Effect commands to retouch pictures.



scanner configuration file
A file, with the extension .CNF, that contains scanner settings. Select Save Configuration As from the Scan menu to save current 
scanner settings. Select Open Configuration from the Scan menu to load previously saved scanner settings. Save scanner settings 
into PHOTO.CNF to automatically load them when you start PhotoFinish.



soft tools
Tools that are capable of producing varying degrees of transparency and paint with adjustable soft strokes that control the rate of 
flow, edges, density, fade out, and spacing.



Preview
Shows how changes will affect your picture before the changes are made. During Preview, you can drag the dialog box aside to see 
more of the picture.



secondary color
Many tools and commands use the secondary color. To change your secondary color, point in the Palette to the color you want and 
click the right mouse button. You can also select the Eyedropper tool, point to a color in your picture, and click the right mouse 
button. The new secondary color appears in the color selection box on the left of your Palette.



temporary files
PhotoFinish temporarily stores information in files on your hard disk if it runs out of memory. Set the drives/directories for 
PhotoFinish to use as temporary storage with the Preferences command on the Options menu. If you quit PhotoFinish abnormally, 
the files remain on your system and can be deleted.



text box
Box in a dialog box you can type in. For example, you type the name of a file in the File Name text box.



tile pattern 
Any small picture loaded from disk or the clipboard, to be used in a tile pattern. Use Tile Pattern to select the tile you want.



thumbnail
A small representation of a picture. Thumbnail files have a file extension that begins with !. For example, a thumbnail file for a .PCX 
has a .!px extension.



title bar
The horizontal bar at the top of windows that shows the title of the program, the title of the window, or information about the loaded 
picture (name, magnification rate, etc.). The left end of the title bar contains the Control menu box and the right end may contain 
minimize and maximize buttons.



Toolbox
Workbox containing the tools you use to create and retouch pictures and add special effects. Choose Screen Layout Toolbox from 
the Display menu, or press Ctrl+T to display or remove the Toolbox.

Click a tool with the left mouse button to choose it. Click a tool with the right mouse button for help on using the tool. Grouped tools 
display a triangle in the bottom right corner.



virtual memory
Allows PhotoFinish to behave as if there were more memory than is actually present in your system by storing temporary files in any
free RAM and disk space.



Width & Shape workbox 
Workbox you display to view or change your tool width or shape. Choose Screen Layout Width & Shape from the Display menu or 
press Ctrl+W to display or remove the Width & Shape workbox. The value in the display box is in pixels even if you select another 
unit of measure. To change the current width, press one of the arrows, drag over the display box and type a number, or click the 
triangle.



work area
Area of your picture you see in a picture window. If a picture extends beyond the work area, use the Hand tool or the scroll bars to 
move other areas into view. Use the Locator tool to display other areas in a duplicated picture. Use the Zoom Out commands to 
display more of a picture at once.



DMA I/O
Data is transferred by your system hardware from memory to some other device without being loaded into the microprocessor.



EMS
Expanded Memory Specification. A standard that allows personal computers to use more than 640K of RAM in DOS. EMS creates a
64K RAM window through which RAM in 64K sections can be swapped as needed.



interrupt request
A signal that can be generated by hardware or software to tell the microprocessor to pause in what it is doing and perform a different
function, such as inputting data from a scanner.



memory address
A number code you can select to specify a location in random access memory.



port address
The location you assign for the interface between your computer and an external device, such as a scanner or printer. You can 
assign a port address to one device at a time.



programmed i/o
Data is transferred by a program from memory to some other memory location or to a device, such as a scanner.



      Blend Paintbrush Tool -- Blending Freehand

To blend areas:    

1 Adjust the tool's width and shape.    

2 Drag the arrow in the Palette to adjust the tool's effect.    

3 Drag over areas you want to change.    

Related Topics:
Blending with the Blend Filter
Changing Color Formats
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Settings



      Brighten Paintbrush Tool -- Brightening Freehand

To brighten areas:    

1 Adjust the tool's width and shape.    

2 Drag the arrow in the Palette to adjust the tool's effect.    

3 Drag over areas you want to change.    

Related Topics:
Adjusting Brightness and Contrast
Changing Color Formats
Changing Your Tool Width and Shape
Finding and Selecting Tools
Fine-Tuning with the Color/Gray Map
Selecting Tool Settings



      Charcoal Tool -- Drawing Freehand with the Charcoal Tool

To use the charcoal tool:    

1 Adjust the tool's width and shape.    

2 Drag the arrow in the Palette to adjust the tool's color, from black to white, and transparency.    
3 Choose Tool Options to change the tool's effect.
4 Drag over areas you want to change.

Related Topics:
Changing Your Brush Style
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Settings



      Contrast Paintbrush Tool -- Changing Contrast Freehand

To adjust contrast in areas:    

1 Adjust the tool's width and shape.    

2 Drag the arrow in the Palette to adjust the tool's effect.    

3 Drag over areas you want to change.    

Related Topics:
Adjusting Brightness and Contrast
Changing Color Formats
Changing Your Highlights and Shadows
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Settings



      Gradient Paint Roller Tool -- Filling an Area with a Gradient

To fill with a gradient:    

1 Choose a secondary and background color.    
2 Choose Gradient Type to adjust the look of the gradient; choose Color Tolerance to adjust the range of 
colors to fill.

3 Place the drop on the pointer inside the area you want to fill.    
4 Click the mouse button inside the area you want to fill.

Related Topics:
Changing Color Formats
Creating a Range of Colors
Filling an Area with a Tile Pattern
Filling an Area with Color
Finding and Selecting Tools
Loading a Palette
Selecting Tool Colors
Undoing Changes to Your Picture
Zooming In and Out with the Zoom Tool



      Smear Paintbrush Tool -- Smearing Colors Freehand

To smear areas:    

1 Adjust the tool's width and shape.    
2 Choose Tool Options to change the tool's effect.
3 Drag over the areas you want to change.

Related Topics:
Changing Color Formats
Changing Your Tool Width and Shape
Finding and Selecting Tools
Smudging Freehand



      Smudge Spraycan Tool -- Smudging Freehand

To smudge areas:    

1 Adjust the tool's width and shape.    
2 Drag over the areas you want to change.

Related Topics:
Changing Your Tool Width and Shape
Finding and Selecting Tools
Smearing Colors Freehand



      Tile Pattern Paint Roller Tool -- Filling an Area with a Tile Pattern

To fill with a tile pattern:    
1 Choose Tile Pattern to open a tile pattern.
2 Choose Color Tolerance to adjust the range of colors to fill; choose Tool Options to change how the tiles

are pasted.

3 Place the drop on the pointer inside the area you want to fill.    
4 Click the mouse button inside the area you want to fill.

Related Topics:
Drawing a Line with a Tile Pattern
Filling an Area with a Gradient
Filling an Area with Color
Finding and Selecting Tools
Selecting Tool Colors
Undoing Changes to Your Picture
Zooming In and Out with the Zoom Tool



Options Tool Options Command -- Choosing How to Paste Your Tile Patterns

To choose how to paste your tile patterns:

Choose how you want to paste your tile patterns into your picture.    

Related Topics:
Drawing a Line with a Tile Pattern
Filling an Area with a Tile Pattern



      Tile Pattern Line Tool -- Drawing a Line with a Tile Pattern

To draw a line with a tile pattern:    
1 Choose Tile Pattern to open a tile pattern.

2 Adjust the spacing for the tiles.    
3 Choose Tool Options to change how the tiles are pasted.
4 Press the left mouse button to anchor the starting point.

5 Drag to where you want to end the line.    

6 You can also draw joined lines or rays joined at a single point.    

Related Topics:
Filling an Area with a Tile Pattern
Finding and Selecting Tools
Selecting Tool Colors
Setting Your Tool Width



      Tint Paintbrush Tool -- Tinting Freehand

To tint areas:    

1 Adjust the tool's width and shape.    
2 Choose a primary color.

3 Drag over the areas you want to change.    

Related Topics:
Changing Color Formats
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors



      Sharpen Paintbrush Tool -- Sharpening Freehand

To sharpen areas:    

1 Adjust the tool's width and shape.    

2 Drag the arrow in the Palette to adjust the tool's effect.    

3 Drag over the areas you want to change.    

Related Topics:
Changing Color Formats
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Settings
Sharpening with the Sharpen Filter



PhotoFinish Tools

You use the tools in the Toolbox to create, add special effects, and retouch your pictures. To choose a 
tool, the Toolbox must be displayed.

For information on selecting tools, see Finding and Selecting Tools. 

Display Tools:
    Zoom changes the magnification of a picture.

    Locator displays selected area in all windows that contain the same duplicated pictures.

    Hand moves your picture vertically, horizontally, or diagonally.

Selection Tools:
    Box Selectiondefines rectangular areas.

    Magic Wand defines areas with similar colors.

    Lasso defines irregular areas.

    Scissors defines polygonal areas.

    Elliptical Selection defines elliptical areas.

Painting Tools:
    Text adds text to your picture.

    Eyedropper selects a color from the picture.

    Eraser erases areas of your picture.

    Color Replacer replaces the primary color with the secondary color.

    Local Undo undoes areas freehand.

    Paintbrush draws freehand shapes with a soft brush.

    Fountain Pen draws freehand shapes.

    Charcoal draws with a charcoal effect freehand.

    Airbrush shades areas freehand with a soft spray.

    Spraycan splatters colors freehand.

    Paint Roller fills enclosed areas with color.

    Tile Pattern Paint Roller fills enclosed areas with a repeating tile pattern.

    Gradient Paint Roller fills enclosed areas with a gradient.

    Line draws single or joined lines.

    Curve draws single or joined curves.

    Tile Pattern Line draws a line with a repeating tile pattern.

    Hollow Box draws hollow boxes.

    Hollow Rounded Box draws hollow rounded boxes.

    Hollow Ellipse/Circle draws single or concentric hollow ellipses or circles.



    Hollow Regular Polygondraws hollow equal-sided polygons.

    Hollow Polygon draws hollow polygons.

    Filled Box draws filled boxes.

    Filled Rounded Box draws filled rounded boxes.

    Filled Ellipse/Circle draws single or concentric filled ellipses or circles.

    Filled Regular Polygon draws filled equal-sided polygons.

    Filled Polygon draws filled polygons.

    Clone paints one area of your picture with another selected area.

Retouch Tools:
    Contrast Paintbrush adjusts contrast freehand.

    Brighten Paintbrush changes the intensity of colors freehand.

    Tint Paintbrush changes shades of color freehand.

    Blend Paintbrush smoothes areas freehand.

    Smear Paintbrush smears colors freehand.

    Smudge Spraycan smudges colors freehand.

    Sharpen Paintbrush sharpens freehand.

Related Topics:
Changing Your Tool Width and Shape
Selecting Tool Colors
Selecting Tool Settings
Showing or Hiding the Toolbox



Finding and Selecting Tools

You use PhotoFinish tools to create, retouch, add special effects to pictures.

To get help on using a tool, click the right mouse button on the tool.

To choose a tool, the Toolbox must be displayed. 

To choose a tool, point to it and click the left mouse button. The tool is highlighted to 
indicate it is selected.

To choose a tool from a group, press the left mouse button on the triangle in the bottom 
right corner of the current tool. When the available tools appear, drag the mouse to the tool you want and 
release the mouse button. The tool appears in the Toolbox and is selected.

Selection tools

Airbrush/Spraycan tools

Paint Roller tools

Line tools

Hollow shape tools

Filled shape tools

Smear/Smudge tools

When you move the pointer over the picture window, it changes shape to remind you 
which tool you selected.

You can move the Toolbox by dragging its title bar.

To use most tools, choose the tool you want and point to where you want to start. Press 
the left mouse button to anchor the starting point, drag the mouse until you have the look you want, and 
release the mouse button.

Related Topics:
Changing Your Tool Width and Shape
Laying Out the Toolbox
Selecting Tool Colors
Selecting Tool Settings



Selecting Tool Colors

The Palette workbox is where you can select the primary, secondary, and background colors for your 
picture. Your Palette changes depending on your picture and the tool you are using. The colors you 
choose are displayed in the color selection box.

To select new colors, the Palette must be displayed.

There are two ways to choose colors:

Point to a color in the Palette and click the appropriate mouse button to select your 
colors.    

 

Use the Eyedropper tool to pick up a color from your picture. Click the appropriate mouse
button to select your colors.    

 

Related Topics:
Changing Your Tool Width and Shape
Finding and Selecting Tools
Folding and Unfolding the Palette
PhotoFinish Tools
Selecting Tool Settings
Working with Different Numbers of Colors



Selecting Tool Settings

The Palette workbox is where you can change settings for some of the retouch tools. The settings you 
choose are displayed in the color selection box.

To select new settings, the Palette must be displayed.

These are three ways to change settings for some of the retouch tools:

Point to the arrow in the workbox and drag to the setting you want. The setting is 
displayed in the color selection box.

Point to the setting you want and click the left mouse button. The arrow moves to the new
setting. The setting is displayed in the color selection box.

Use the mini-scroll bar in the color selection box.

Related Topics:
Changing Tool Settings
Changing Your Tool Width and Shape
Finding and Selecting Tools
Folding and Unfolding the Palette
PhotoFinish Tools
Selecting Tool Colors



Changing Your Tool Width and Shape

You use the Width & Shape workbox to change the width and shape of some tools.

To change your tool width or shape in the Width & Shape workbox, it must be displayed. 

To change your tool width and shape:

Click or press one of the arrows on the mini-scroll bar.

Click the shape button on the left side of the workbox.    

Related Topics:
Changing Tool Settings
Finding and Selecting Tools
PhotoFinish Tools
Selecting Tool Colors
Selecting Tool Settings



      Zoom Tool -- Zooming In and Out with the Zoom Tool

To change the magnification of a picture:    
1 Point to the area you want to zoom.

2 Click the left mouse button to zoom in.    

3 Click the right mouse button to zoom out.    

4 Continue clicking the mouse button to cycle through the Zoom command percentages.    

Related Topics:
Finding and Selecting Tools
Viewing a Picture in Multiple Views
Viewing the Same Area in Multiple Windows
Zooming In and Out with the Zoom Commands
Zooming to Fit



      Hand Tool -- Moving Areas of Your Picture into View

To move your picture with the Hand tool:    

Drag the picture to bring the area you want into view.

Related Topics:
Finding and Selecting Tools
Scrolling
Viewing a Picture in Multiple Views
Viewing the Same Area in Multiple Windows



      Locator Tool -- Viewing the Same Area in Multiple Windows

To locate the same area of a picture in two or more windows:    

Click in one picture on the area you want to show in all windows that contain duplicate 
copies.    

Related Topics:
Finding and Selecting Tools
Moving Pictures into View
Scrolling
Viewing a Picture in Multiple Views
Zooming In and Out with the Zoom Commands
Zooming In and Out with the Zoom Tool
Zooming to Fit



      Eyedropper Tool -- Picking Up a Color from the Screen

To pick up a color from the screen with the Eyedropper tool:
1 Point to the color you want to pick up from your picture.
2 Choose Tool Options to change how PhotoFinish calculates the color to select.

3 Click the appropriate mouse button to select your colors.    

Related Topics:
Finding and Selecting Tools
Selecting Tool Colors
Working with Different Numbers of Colors



Options Tool Options Command-- Setting the Effect of the Eyedropper Tool

To set how the Eyedropper tool selects colors:

To select an exact color, choose Single Pixel.

To select an average color in a group, choose an average option.    

Related Topics:
Picking Up a Color from the Screen



      Box Selection Tool -- Defining a Rectangular Area

To define a cutout with the Box Selection tool:    
1 Select a background color if you plan to cut, delete, or move the cutout.
2 Press the left mouse button to anchor the starting point.

3 Drag to surround the area you want.    

4 Release the mouse button.    

Related Topics:
Defining a Polygonal Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Defining an Irregular Area
Finding and Selecting Tools
Manipulating Defined Areas



      Lasso Tool -- Defining an Irregular Area

To define a cutout with the Lasso tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.
2 Press the left mouse button to anchor the starting point.
3 Drag to surround the area you want to define.

4 Release the mouse button to complete the cutout.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Finding and Selecting Tools
Manipulating Defined Areas



      Scissors Tool -- Defining a Polygonal Area

To define a cutout with the Scissors tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.
2 Click the mouse button to anchor the starting point.

3 Continue clicking around the area you want to define.    

4 Double-click to end the last line and complete the cutout.    

Related Topics:
Defining a Rectangular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Defining an Irregular Area
Finding and Selecting Tools
Manipulating Defined Areas



      Magic Wand Tool -- Defining an Area of Similar Colors

To define a cutout with the Magic Wand tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.
2 Choose Color Tolerance to adjust the range of colors for selection.

3 Point to the area you want to select and click the left mouse button.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Elliptical Area
Defining an Irregular Area
Finding and Selecting Tools
Manipulating Defined Areas



      Elliptical Selection Tool -- Defining an Elliptical Area

To define a cutout with the Elliptical Selection tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.
2 Press the left mouse button to set the center of the ellipse.

3 Drag outward to surround the area you want.    

4 Release the mouse button to complete the cutout.    

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Area of Similar Colors
Defining an Irregular Area
Finding and Selecting Tools
Manipulating Defined Areas



Manipulating Defined Areas

Define the cutout with a selection tool and a marquee surrounds the selected area.    

To permanently paste the cutout, click outside the marquee, choose a tool, or choose Edit Select None.

You can manipulate cutouts in the following ways:

Point inside the marquee and drag to move the cutout to another location.

Choose Edit Select Transparent or drag with the right mouse button to make the 
background color of the cutout transparent.

Deselect Edit Select Transparent or drag with the left mouse button to make the cutout 
opaque.

Choose Edit Select Leave Original or hold down Shift while you drag to leave a single 
copy behind.

Hold down Ctrl while you drag to leave a trail of copies behind.

You can also use the arrow keys to move the cutout one pixel at a time.

Choose Image Transform Resize if you want the gadget box to appear around the cutout.
A check mark appears beside the command to show that it is selected.

Choose a command from the Edit or Image menu to manipulate the cutout in other ways. 
For example, you can apply the Filter, Tune, Special Effect, and Transform commands.

Related Topics:
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Area of Similar Colors
Defining an Elliptical Area
Defining an Irregular Area
The Edit Menu
The Image Menu



      Local Undo Tool -- Undoing Some Changes

To undo some changes:    

1 Adjust the tool's width and shape.    

2 Drag over areas you want to return to their previous look.    

Related Topics:
Changing Your Tool Width and Shape
Clearing Your Picture to the Background Color
Erasing Parts of Your Picture
Finding and Selecting Tools
Replacing One Color with Another
Restoring Your Previous Version
Undoing Changes to Your Picture



      Eraser Tool -- Erasing Parts of Your Picture

To erase area of your picture:

1 Choose a background color.    

2 Adjust the tool's width and shape.    

3 Drag over areas you want to erase.    

Related Topics:
Changing Your Tool Width and Shape
Clearing Your Picture to the Background Color
Finding and Selecting Tools
Replacing One Color with Another
Restoring Your Previous Version
Selecting Tool Colors



      Text Tool -- Adding Text to Your Picture

To add text to your picture:
1 Select a font.
2 Choose a secondary color for your text.

3 Choose the Text tool and type your text in the Enter Text dialog box.    

4 Choose OK.    

5 To make changes to your text, do so before you paste it.    
6 Click outside the Text Frame or choose another tool to paste the text.

Related Topics:
Adding Fonts to the Font List
Finding and Selecting Tools
Selecting Tool Colors



      Paint Roller Tool -- Filling an Area with Color

To fill an area with color:    
1 Choose a primary color or secondary color.
2 Choose Color Tolerance to adjust the range of colors to fill.

3 Place the drop on the pointer inside the area you want to fill.    
4 Click the mouse button inside the area you want to fill.

Related Topics:
Filling an Area with a Gradient
Filling an Area with a Tile Pattern
Finding and Selecting Tools
Selecting Tool Colors
Undoing Changes to Your Picture
Zooming In and Out with the Zoom Tool



      Spraycan Tool -- Splattering Color with the Spraycan

To splatter colors:    
1 Choose a primary color or secondary color.

2 Adjust the tool's width and shape.    
3 Point to the area you want to spray.
4 Drag over the areas you want to spray.

Related Topics:
Changing Your Brush Style
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors
Shading with the Airbrush



      Airbrush Tool -- Shading with the Airbrush

To add shading to your picture:    
1 Choose a primary color or secondary color.

2 Adjust the tool's width and shape.    
3 Choose Tools Options to change the tool's effect.
4 Drag over the areas you want to spray.

Related Topics:
Changing Color Formats
Changing Your Brush Style
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors
Splattering Color with the Spraycan



      Paintbrush Tool -- Brushing Freehand

To use the Paintbrush tool:    
1 Choose a primary or secondary.

2 Adjust the tool's width and shape.    
3 Choose Tool Options to change the tool's effect.
4 Point to where you want to start.

5 Drag to paint freehand.    

Related Topics:
Changing Your Brush Style
Changing Your Tool Width and Shape
Changing Color Formats
Drawing Freehand Shapes
Finding and Selecting Tools
Selecting Tool Colors



      Fountain Pen Tool -- Drawing Freehand Shapes

To use the Fountain Pen tool:
1 Choose a primary color.

2 Adjust the tool's width and shape.    

3 Drag over the area you want to change.    
4 You can click the right mouse button on a color in your picture to select it as the primary color.

Related Topics:
Brushing Freehand
Changing Your Brush Style
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors



      Color Replacer Tool -- Replacing One Color with Another

To replace colors:    
1 Choose a primary color (the color you want to change) and a secondary color (the color you want the 

Color Replacer to use).

2 Adjust the tool's width and shape.    
3 Choose Color Tolerance to adjust the range of colors to replace.

4 Drag over areas you want to change.    

Related Topics:
Changing Color Formats
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors



      Curve Tool -- Drawing Single and Joined Curves

To draw a curve:    
1 Choose a primary color.

2 Adjust the tool's width and shape.    
3 Press the left mouse button to anchor the starting point.
4 Drag to where you want the curve to end.

5 Use the handles to adjust the curve.    

6 Click outside the curve to paste it.    

Related Topics:
Changing Your Tool Width and Shape
Drawing Single and Joined Lines
Finding and Selecting Tools
Selecting Tool Colors



      Line Tool -- Drawing Single and Joined Lines

To draw a line:    
1 Choose a primary color.

2 Adjust the tool's width and shape.    
3 Press the left mouse button to anchor the starting point.

4 Drag to where you want to end the line.    

5 You can also draw joined lines or rays joined at a single point.    

Related Topics:
Changing Your Brush Style
Changing Your Tool Width and Shape
Drawing a Line with a Tile Pattern
Drawing Single and Joined Curves
Finding and Selecting Tools
Selecting Tool Colors



      Hollow Box Tool -- Drawing a Hollow Box

To draw a box:    

1 Choose a primary color.    

2 Adjust the width of the border.    
3 Press the left mouse button to anchor the beginning of the shape.

4 Drag to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Box
Drawing a Hollow Rounded Box
Finding and Selecting Tools
Selecting Tool Colors



      Filled Box Tool -- Drawing a Filled Box

To draw a filled box:    

1 Choose a primary and secondary color.    

2 Adjust the width of the border.    
3 Press the left mouse button to anchor the starting point.

4 Drag to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Rounded Box
Drawing a Hollow Box
Finding and Selecting Tools
Selecting Tool Colors



      Hollow Rounded Box Tool -- Drawing a Hollow Rounded Box

To draw a rounded box:    

1 Choose a primary color.    

2 Adjust the width of the border.    
3 Press the left mouse button to anchor the starting point.

4 Drag to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Rounded Box
Drawing a Hollow Box
Finding and Selecting Tools
Selecting Tool Colors



      Filled Rounded Box Tool -- Drawing a Filled Rounded Box

To draw a filled rounded box:    

1 Choose a primary and secondary color.    

2 Adjust the width of the border.    
3 Press the left mouse button to anchor the starting point

4 Drag to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Box
Drawing a Hollow Rounded Box
Finding and Selecting Tools
Selecting Tool Colors



      Hollow Ellipse/Circle Tool -- Drawing a Hollow Ellipse/Circle

To draw a hollow ellipse/circle:    

1 Choose a primary color.    

2 Adjust the width of the border.    
3 Press the left mouse button to set the center point.

4 Drag outward to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Ellipse/Circle
Finding and Selecting Tools
Selecting Tool Colors



      Filled Ellipse/Circle Tool -- Drawing a Filled Ellipse/Circle

To draw a filled ellipse/circle:    

1 Choose a primary and secondary color.    

2 Adjust the width of the border.    
3 Press the left mouse button to set the center point.

4 Drag outward to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Hollow Ellipse/Circle
Finding and Selecting Tools
Selecting Tool Colors



      Filled Regular Polygon Tool -- Drawing a Filled Equal-sided Polygon

To draw a filled regular polygon:

1 Choose a primary and secondary color.    

2 Adjust the width of the border.    

3 Choose Tool Options to specify the number of sides for the polygon.    
4 Press the left mouse button to set the center point.

5 Drag outward to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Polygon
Drawing a Hollow Polygon
Drawing a Hollow Equal-sided Polygon
Finding and Selecting Tools
Selecting Tool Colors



      Hollow Regular Polygon Tool -- Drawing a Hollow Equal-sided Polygon

To draw a hollow regular polygon:    

1 Choose a primary color.    

2 Adjust the width of the border.    

3 Choose Tool Options specify the number of sides for the polygon.    
4 Press the left mouse button to set the center point.

5 Drag outward to draw the shape.    

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Polygon
Drawing a Filled Equal-sided Polygon
Drawing a Hollow Polygon
Finding and Selecting Tools
Selecting Tool Colors



Options Tool Options Commands -- Changing the Number of Sides for Your 
Regular Polygon

To set the number of sides for your regular polygon:

Use the mini-scroll bar or type the number of sides you want.    

Related Topics:
Drawing a Filled Polygon
Drawing a Filled Equal-sided Polygon
Drawing a Hollow Equal-sided Polygon
Drawing a Hollow Polygon



      Hollow Polygon Tool -- Drawing a Hollow Polygon

To draw a hollow polygon:    

1 Choose a primary color.    

2 Adjust the width of the border.    
3 Click the mouse button to anchor the starting point.

4 Continue clicking to draw the shape.    
5 Double-click to end the last line and complete the shape.

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Polygon
Drawing a Filled Equal-sided Polygon
Drawing a Hollow Equal-sided Polygon
Finding and Selecting Tools
Selecting Tool Colors



      Filled Polygon Tool -- Drawing a Filled Polygon

To draw a filled polygon:    

1 Choose a primary and secondary color.    

2 Adjust the width of the border.    
3 Click the mouse button to anchor the starting point.

4 Continue clicking to draw the shape.    
5 Double-click to end the last line and complete the shape.

Related Topics:
Changing Your Tool Width and Shape
Drawing a Filled Equal-sided Polygon
Drawing a Hollow Polygon
Drawing a Hollow Equal-sided Polygon
Finding and Selecting Tools
Selecting Tool Colors



      Clone Tool -- Replacing One Area with Another Freehand

To use the Clone tool:    

1 Adjust the tool's width and shape.    

2 Choose Tool Options to change the tool's effect.    

3 Click the right mouse button on the area you want to clone (source).    

4 Drag to begin cloning.    

Related Topics:
Changing Your Tool Width and Shape
Finding and Selecting Tools
Pasting from Disk
Pasting from the Clipboard
Working with Different Numbers of Colors



The Help Menu

You use Help menu commands to open the PhotoFinish Help program and learn more about commands, 
procedures, tools, and shortcuts. You can also use Help menu commands to see the version of 
PhotoFinish you are using.

To learn how to use on-line help, choose How to Use Help from the Help menu. Choose Search for Help 
on to search for help on topics that relate to a specific word or phrase.

To choose a Help menu command, click Help and choose a command.

Help Menu Commands
Contents: Lists topics you can choose from.
Commands: Lists and explains PhotoFinish menus.
Procedures: Lists topics that help you create, edit, view, and print pictures, use tools, scan, work with 

files, and work with colors.
Shortcuts: Explains shortcuts for choosing commands and selecting options.
Tools: Explains how to use PhotoFinish tools.
For Beginners: Explains basic PhotoFinish information.



For Beginners

Welcome to PhotoFinish's help for beginners.

If you are unfamiliar with ZSoft's PhotoFinish program, choose from the topics listed below. For more help
on PhotoFinish, choose a command from the PhotoFinish Help menu, choose Help in any dialog box, 
click the right mouse button on a tool, browse through the Help system, or read the PhotoFinish User's 
Guide.

To learn about PhotoFinish Help features, point to the picture of the key and press the left mouse button.

To choose a Help topic with the mouse, point to words that have a solid underline. When your pointer 
becomes a hand, click the left mouse button. To read a glossary term, point to words with a dotted 
underline and press the left mouse button.

To choose a Help topic with the keyboard, tab to words that have a solid underline and press Enter. To 
read a glossary term, tab to words with a dotted underline and press and hold Enter.

To learn how to use Windows on-line Help, choose How to Use Help from the Help menu in the 
PhotoFinish Help program. For help running Windows, check your Microsoft Windows User's Guide.

Help for Beginners
Calibrating Your Devices
Changing Your Tool Width and Shape
Finding and Selecting Tools
PhotoFinish Commands
Scrolling
Selecting Tool Colors
Selecting Tool Settings
Using Filter Commands
Using PhotoFinish Windows
Using Special Effect Commands
Using Tune Commands
Viewing Colors on Your Screen
Working with Different Numbers of Colors



Using PhotoFinish Windows

PhotoFinish loads pictures into picture windows. The window's title bar displays the picture's name, 
magnification percentage, and the order in which it was opened or duplicated.

You can move, resize, and close a window, or reduce it to an icon.

To move a window to another location, drag the window's title bar.

To resize a window, place your pointer on a window border. When your pointer becomes 
a double-sided arrow, drag to resize the window.

To close, maximize, and minimize a window, choose appropriate commands from the 
window's Control menu.

Your Toolbox, Palette, and Width & Shape workbox are individual workboxes you can show, hide, and 
move to control your desktop layout.

Related Topics:
Opening an Existing Picture
Showing or Hiding the Palette
Showing or Hiding the Status Bar
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape workbox
Showing or Hiding Workboxes
Viewing a Picture in Multiple Views



Scrolling

You use scroll bars to display parts of your picture that don't fit in the picture window and portions of lists 
that are out of view. You can also use the Hand to move a picture around a window. The Hand works like 
scroll bars, but it also lets you move diagonally.

Mini-scroll bars let you cycle through fields in a dialog box instead of typing numbers.

To use a scroll bar:    

Click a scroll arrow to move line-by-line.

Press a scroll arrow to move continuously.

Drag the scroll box to the general location you want to see.

Click inside the scroll bar to move the scroll box to that location.

To use a mini-scroll bar:    

Click a scroll arrow to increase or decrease numbers by single increments.

Press a scroll arrow to move continuously.

Point to the middle of the scroll bar. When your pointer is a double-sided arrow with lines 
through the center, drag up or down to scroll through available values.



PhotoFinish Commands

You choose PhotoFinish commands from the menus along the top of the PhotoFinish desktop.

To choose a command, click the menu name in the menu bar and click the command you want. Some 
commands are on cascading menus.

File Menu: You use File menu commands to start new pictures, load and save pictures, print pictures, 
select your printer and change printer options, calibrate your printer, and exit PhotoFinish.

Edit Menu: You use Edit menu commands to correct mistakes, copy or cut to the Clipboard or to disk, 
paste from the Clipboard or disk, and clear a picture to the background color.

Image Menu: You use Image menu commands to change the color format of pictures, apply filters, special
effects, and tune-up pictures or cutouts. You can also flip, resize, and rotate pictures or cutouts. You 
can also clear your picture to the selected background color.

Scan Menu: You use Scan menu commands to scan and set scanning options, stitch images together, 
rescan images, calibrate your scanner, and load and save scanner configurations,

Display Menu: You use Display menu commands to zoom in or out on your picture, set the layout of your 
desktop, optimize your display, and calibrate your monitor.

Options Menu: You use Options menu commands to change your palette, change tool shapes and 
settings, load a tile pattern, select startup preferences, select and style fonts, choose a different 
loaded font, and choose other program options. 

Window Menu: You use Window menu commands to duplicate an opened picture, rearrange PhotoFinish 
picture windows, rearrange minimized pictures, and change your active picture.

Help Menu: You use Help menu commands to open the PhotoFinish Help program and learn more about 
commands, procedures, tools, and shortcuts. You can also use Help menu commands to get 
information about the version of PhotoFinish you are using.

Control Menu: You use Control menu commands on the PhotoFinish program and picture windows to 
move, close, restore, and change the size of the window. Control menu commands on the 
PhotoFinish workboxes move and hide the workboxes. The Toolbox Control menu also has the 
Layout command, and the Palette Control menu also has the Fold/Unfold command. Picture window 
control menus also have Image Info and Image Resolution commands.



Procedures

Calibrating Your Devices: Explains how to adjust for your scanner, printer, and monitor for best results.
Editing a Picture: Lists procedures for creating and improving pictures.
Painting with PhotoFinish: Lists procedures for using PhotoFinish tools.
Printing: Lists procedures for printing pictures and calibrating your printer.
Retouching and Enhancing Pictures: Lists procedures for using tools, and Filter, Tune, and Special Effect 

commands to improve images.
Scanning: Lists procedures you use to choose scanner options, load and save scanner settings, calibrate 

your scanner, and scan pictures.
Working with Colors: Lists procedures you use to work with different color formats, create colors and 

gradients, load and change palettes, and manipulate the colors in your pictures.
Working with Files: Lists procedures for working with PhotoFinish files.
Working with Windows: Lists procedures for working with windows in PhotoFinish.



PhotoFinish Shortcuts

PhotoFinish provides many shortcuts to help you work more efficiently. You will often find the use of 
accelerator keys and mouse double-clicks to be faster than choosing commands from menus. In addition, 
many PhotoFinish tools can be constrained so that you can draw perfect lines and geometric shapes.

Choose a topic below for more information.

Keyboard Shortcuts

Double-Click Shortcuts

Tool Constraints



Keyboard Shortcuts

Use accelerator keys, shown beside some commands, to select a command. For example, use Ctrl+X to 
exit PhotoFinish. You can also hold down Alt and type the underlined letter in a menu and the underlined 
letter in the command. For example, use the following keys to cut, copy, and paste: Alt+E,T to cut, Alt+E,C
to copy, Alt+E,P to paste.

PhotoFinish Keystrokes

This key... ...does this.

Alt+F4 closes PhotoFinish.
Arrow keys moves a cutout one pixel at a time.
Ctrl+1 returns a picture to one-to-one view.
Ctrl+A shows or removes the Width & Shape, Palette, and Toolbox workboxes.
Ctrl+B shows or removes the status bar.
Ctrl+C copies a defined area.
Ctrl+D duplicates the current picture.
Ctrl+F makes more work space available.
Ctrl+G rescans with your current scanning settings.
Ctrl+N scans an image.
Ctrl+O displays the tool options dialog box specific to the selected tool, if available.
Ctrl+P shows or removes the Palette workbox.
Ctrl+S saves your picture.
Ctrl+T shows or removes the Toolbox workbox.
Ctrl+V pastes a cutout from the Clipboard.
Ctrl+W shows or removes the Width & Shape workbox.
Ctrl+X cuts a defined area.
Ctrl+Z undoes recent changes.
Del deletes the defined area without copying it to the Clipboard.
Esc erases some tools' effects before you release the mouse button.
F1 displays the PhotoFinish on-line Help system.
Shift+F4 tiles the windows on your PhotoFinish desktop.
Shift+F5 cascades the windows on your PhotoFinish desktop.

Windows Keystrokes

This key... ...does this.

Alt+spacebar opens the program Control menu.
Alt+up or down arrow opens a drop-down list after you tab to the list box.
Arrow keys moves within a list, display box, or group of choices in a dialog box.
Ctrl+F4 closes the current picture.
Ctrl+F6 switches to the next picture.
Enter chooses a highlighted command, selects an item from a list, and completes 



commands.
Esc cancels a dialog box.
F1 opens the on-line Help system and displays the Contents.
Shift+Tab moves from one area to another in a dialog box in reverse order.
Spacebar chooses a selection in a list or a check box option. Press the spacebar again to 

deselect the option.
Tab moves from one area to another in a dialog box.

Related Topics:
PhotoFinish Shortcuts
Double-Click Shortcuts



Double-Click Shortcuts

For some tools, double-clicking is a quick way to modify some PhotoFinish settings or to select some 
options.

Click the brush style button in the Width & Shape workbox to display the Select a Brush Style dialog box.

Airbrush

Blend Paintbrush

Box Selection

Brighten Paintbrush

Charcoal

Clone

Color Replacer

Contrast Paintbrush

Curve

Elliptical Selection

Eraser

Eyedropper

Filled Regular Polygon

Fountain Pen

Gradient Paint Roller

Hollow Regular Polygon

Lasso

Line

Local Undo

Magic Wand

Paint Roller

Paintbrush

Scissors

Sharpen Paintbrush

Smear Paintbrush



Smudge Paintbrush

Spraycan

Tile Pattern Line

Tile Pattern Paint Roller

Tint Paintbrush

Zoom

Related Topics:
Adjusting the Effect of Soft Brush Tools
Changing the Number of Sides for Your Regular Polygon
Changing Your Brush Style
Keyboard Shortcuts
PhotoFinish Shortcuts
PhotoFinish Tools
Setting the Effect of the Eyedropper Tool
Specifying Color Tolerance



Tool Constraints

For some tools, holding down Shift while you drag the mouse constrains the shape or direction of the 
effect. Press the spacebar to switch between horizontal and vertical constraint. Release the Shift key to 
use the tools normally.

Airbrush tool

Selection tools

Box tools

Clone tool

Color Replacer tool

Ellipse tools

Eraser tool

Fountain Pen tool

Line tools

Local Undo tool

Paintbrush tools

Polygon tools

Regular Polygon tools

Related Topics:
PhotoFinish Shortcuts
PhotoFinish Tools



Trademarks and Tradenames

PhotoFinish, PhotoLibrary, and AutoEnhance are trademarks of ZSoft Corporation. ZSoft is a trademark 
and registered tradename of ZSoft Corporation.

Other product names mentioned may be trademarks or registered trademarks of their respective 
companies. Some trademarks may be registered in countries other than the U.S.



Update Info

Welcome to PhotoFinish!

This topic contains a summary or what is new in PhotoFinish 2.0. It also contains specific release 
information and other items that became available after the PhotoFinish manuals went to print.

PhotoFinish version 2.0 or higher runs under Windows 3.0 or higher. All of the pictures you created in 
older versions of ZSoft's paint programs can be loaded and edited in PhotoFinish version 2.0 or higher.

What's New in PhotoFinish 2.0

PhotoFinish has new commands you can use to calibrate your printer, scanner, and 
monitor for better looking printed, scanned, and displayed pictures. Calibrating your devices helps to 
adjust for any discrepancies between your devices and produces a better looking picture for output.

PhotoFinish has moved some commands to other locations on the menu bar. The 
Brightness and Contrast, Color/Gray Map, and Equalize filters have been moved to the Image Tune 
cascading menu. The Edge Detect, Emboss, and Motion Blur filters have been moved to the Image 
Special Effect cascading menu. The Mosaic filter has been renamed Pixelate and has been moved to the 
Image Special Effect cascading menu. Edit Transform Invert has been renamed and moved to Image 
Tune Negative. Edit Transform Outline has been moved to the Image Special Effect menu.

In addition to commands that have moved, there are many new image enhancement 
commands, including Image Filter Blur, Image Filter Maximum, Image Filter Minimum, Image Filter 
Posterize, Image Filter Remove Moiré, Image Special Effect Apply Texture, Image Special Effect Black 
Hole, Image Special Effect Crystallize, Image Special Effect Facet, Image Special Effect Fisheye Lens, 
Image Special Effect Mosaic, Image Special Effect Twist, and Image Tune Hue and Saturation.

PhotoFinish has added two new automatic enhancement features that will greatly 
improve the quality of your picture as well as cut down on the time it takes to perform certain actions. The 
first of the added automatic features is Image AutoEnhance. This features allows you to specify certain 
actions, such as automatically removing moiré patterns from your picture to improve the quality of your 
picture. The second added automatic feature is Scan AutoScan. The feature allows you to have 
PhotoFinish automatically scan and improve the quality of a scanned image. You can specify several 
options for PhotoFinish to use in the enhancement of the image.

PhotoFinish has added several new painting, selection, and effects tools to help you with 
your projects. The new tool are: Elliptical Selection, Filled Regular Polygon, Hollow Regular Polygon, Tile 
Pattern Line, and Charcoal.

PhotoFinish has added several new commands to resize your picture freehand, resize 
your picture by a specified amount, and to rotate your picture. Many of these commands were previously 
available with the gadget box or with Edit Transform commands.

The Scan commands have been moved from the File Menu to the Scan menu. 
Commands to automatically scan your image and to calibrate your scanner have been added to the list of 
scanning commands.

The commands to display and hide the PhotoFinish workboxes have been moved from 
the Display Workboxes command to the Display Screen Layout command.

The Help bar has been renamed the status bar and can be displayed and removed with 



the Display Screen Layout commands.

The Font menu commands have been moved to the Options menu.

The Font Select command has been renamed Options Font More Fonts.

A Viewer has been added to the File menu. With the File Viewer command you can 
browse through thumbnails, copy, move, delete, or rename picture files.

A Revert command has been added to the File menu. With the Revert command you can 
abandon all changes since the last time you saved your picture.

You can use PhotoFinish to embed or link pictures in other applications that support 
Object Linking and Embedding (OLE).

A Crop command has been added to the Edit menu. With the Crop command you can 
automatically copy a defined area to a new picture window.

Additional Scanner Support

The scanner listed below become available after the PhotoFinish manuals went to print. 
Information about this scanner is in the Setup on-line Help and the PFREADME.TXT.

Jovian SuperVIA Video Capture Board.

Niscan Spectra.



The Display Menu

You use Display menu commands to zoom in or out on your picture, set the layout of your desktop, 
optimize your display, view only your picture, and to calibrate your monitor.

To choose a Display menu command, click Display and choose the command. Some commands are on 
cascading menus.

Display Menu Commands
100% (No Zoom): Returns a picture to one-to-one view.
Zoom: Magnifies or shrinks the active picture.
Zoom To Fit: Shrinks or magnifies your picture to fit your PhotoFinish desktop.
Screen Layout Show/Hide All Workboxes: Displays or hides the Width & Shape, Palette, and Toolbox 

workboxes.
Screen Layout Palette: Displays or hides the Palette workbox.
Screen Layout Toolbox: Displays or hides the Toolbox workbox.
Screen Layout Width & Shape: Displays or hides the Width & Shape workbox.
Screen Layout Cross Hair: Adds or removes a cross hair to the cursor for easy alignment.
Screen Layout Status Bar Displays or hides context-sensitive help at the bottom of your screen.
Full Screen: Removes the title bar and menu bar from your screen and maximizes your desktop. You can 

edit a picture in Full Screen mode.
Show Screen: Removes everything but the active picture from your screen. You cannot edit a picture in 

Show Screen mode.
Calibrate Monitor: Compensates for differences between your monitor and the original picture.
Optimize Display: Improves the on-screen look of your pictures if they contain more colors than your 

monitor supports.



Display Zoom Commands -- Zooming In and Out with the Zoom Commands

To shrink or magnify a picture:    

Choose the Zoom percentage you want from the Display menu.

If you zoom by 800% or greater, PhotoFinish displays a grid that shows individual pixels.

Related Topics:
Editing Your Picture Full Screen
Viewing a Picture in Multiple Views
Viewing the Same Area in Multiple Windows
Viewing Your Picture with No Zoom
Zooming In and Out with the Zoom Tool
Zooming To Fit



Display 100% (No Zoom) Command -- Viewing Your Picture with No Zoom

To return to 100% view:

Choose 100% (No Zoom) from the Display menu.    

Related Topics:
Editing Your Picture Full Screen
Zooming In and Out with the Zoom Commands
Zooming In and Out with the Zoom Tool
Zooming to Fit



Display Zoom To Fit Command -- Zooming to Fit

To zoom so that the picture fits the PhotoFinish desktop:

Choose Zoom To Fit from the Display menu.    

Related Topics:
Editing Your Picture Full Screen
Viewing Your Picture with No Zoom
Zooming In and Out with the Zoom Commands
Zooming In and Out with the Zoom Tool



Display Cross Hair Command -- Showing or Hiding the Cross Hair

To show or hide the cross hair:    

Choose Screen Layout Cross Hair from the Display menu.    

The Cross Hair is useful for aligning objects.

Choose the Cross Hair command again to remove the cross hair.    



Display Screen Layout Show/Hide All Workboxes Command -- Showing or Hiding 
Workboxes

To show or hide all of the workboxes:

Choose the Hide All Workboxes command from the Display menu to hide the workboxes 
that are displayed.    

Choose the Show All Workboxes command from the Display menu to display all the 
workboxes at once.    

Related Topics:
Editing Your Picture Full Screen
Folding and Unfolding the Palette
Laying Out the Toolbox
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape Workbox



Display Screen Layout Width & Shape Command -- Showing or Hiding the Width 
& Shape Workbox

To show or hide the Width & Shape workbox:

Choose the Screen Layout Width & Shape command to display the Width & Shape 
workbox.    

Choose the Screen Layout Width & Shape command again to hide the workbox.    

Related Topics:
Editing Your Picture Full Screen
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding Workboxes



Display Screen Layout Palette Command -- Showing or Hiding the Palette

To show or hide the Palette:

Choose the Palette command to display the Palette workbox.    

Choose the Palette command again to hide the workbox.    

Related Topics:
Editing Your Picture Full Screen
Folding and Unfolding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape Workbox
Showing or Hiding Workboxes



Display Screen Layout Toolbox Command -- Showing or Hiding the Toolbox

To show or hide the Toolbox:

Choose the Toolbox command to display the Toolbox workbox.    

Choose the Toolbox command again to hide the workbox.    

Related Topics:
Editing Your Picture Full Screen
Laying Out the Toolbox
Showing or Hiding the Palette
Showing or Hiding the Width & Shape Workbox
Showing or Hiding Workboxes



Display Screen Layout Status Bar Command -- Showing or Hiding the Status Bar

To show or hide status bar:    

Choose the Status Bar command to display the status bar.    

Choose the Status Bar command again to hide the status bar.    



Display Full Screen Command -- Editing Your Picture Full Screen

To edit your picture full screen:    

Choose Full Screen from the Display menu.    

 Press Ctrl+F to return to normal view.

You can also click the double arrows on the right side of the status bar to switch between 
full screen and normal view.

Related Topics:
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape Workbox
Showing or Hiding Workboxes
Viewing Only Your Picture



Display Show Screen Command -- Viewing Only Your Picture

To view only the picture:    

1 Choose OK to view your active picture full-screen.    
2 Press Esc to return to the normal PhotoFinish screen.

Related Topics:
Editing Your Picture Full Screen
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape Workbox
Showing or Hiding Workboxes



Display Calibrate Monitor Command -- Calibrating Your Monitor

To load a preset map:    

1 Choose the map you want from the Preset Maps drop-down list.    
2 Choose OK to use the map.

3 You can choose Options to create a new map, recalibrate, edit, or delete the selected map.    

Related Topics:
Calibrating Your Devices
Creating a New Monitor Calibration Map
Editing a Monitor Calibration Map
Recalibrating Your Monitor



Recalibrating Your Monitor

To recalibrate your monitor:

1 Click on the box whose center looks most like its border for red, green, blue, and gray.    
2 Choose OK to save your changes to disk and use your new settings.

Related Topics:
Calibrating Your Devices
Creating a New Monitor Calibration Map
Editing a Monitor Calibration Map



Creating a New Monitor Calibration Map

To create a new calibration map:
1 Choose a preset map that the new map is to be based on from the Based On drop-down list.
2 Type a name for the new calibration map in the File Name text box.

3 Choose OK save the map to disk.    
4 Click Recalibrate to recalibrate your monitor and save it to the new map.
5 Click Edit to fine-tune the map.

Related Topics:
Calibrating Your Devices
Calibrating Your Monitor
Editing a Monitor Calibration Map
Recalibrating Your Monitor



Editing a Monitor Calibration Map

To edit a monitor calibration map:    

1 Choose a channel to specify the colors to be adjusted.    

2 Adjust the curve to get the effect you want.    

3 Choose OK to save your changes to disk and use your map.    

Related Topics:
Calibrating Your Devices
Calibrating Your Monitor
Creating a New Monitor Calibration Map
Recalibrating Your Monitor



Display Optimize Display Command -- Optimizing Your Display

To enhance your screen display:

Select Optimize Display.    

Choose the command again to return to a normal display.

Related Topics:
Calibrating Your Monitor
Selecting Preferences



The Options Menu

You use Options menu commands to change your palette, change tool shapes and settings, load a tile 
pattern, select startup preferences, select and style fonts, choose a different loaded font, get system 
information, and choose other program options. 

To choose an Options menu command, click Options and choose the command. Some commands are on
cascading menus.

Options Menu Commands
Tool Options: Changes the settings for soft brush and tile pattern tools. You can also change the results 

you get with the Eyedropper tool and the number of sides you want with the Regular Polygon tools.
Brush Style: Changes the shape and size of all paintbrush tools and the Airbrush, Clone, Charcoal, Color 

Replacer, Eraser, Fountain Pen, Line, and Local Undo tools.
Color Tolerance: Specifies a color range to fill, select, or replace with the paint roller tools, Magic Wand, 

and Color Replacer.
Font More Fonts: Allows you to open fonts and specify font styles and sizes.
Gradient Type: Changes the direction and brightness of the gradient for the Gradient Paint Roller.
Palette All Colors: Adjusts all colors in the palette..
Palette Color Picker: Adjusts individual colors in the palette.
Palette Range of Colors: Creates gradations of colors in the palette.
Palette Single Colors: Adjusts individual colors in the palette. 
Palette Open Palette: Loads a palette previously saved to disk.
Palette Save Palette As: Saves a palette to disk.
Tile Pattern: Loads a picture from disk or the Clipboard to use with the Tile Pattern Paint Roller and Tile 

Pattern Line tools.
Preferences: Adjusts some settings for program startup, context sensitive help, PhotoFinish's virtual 

memory path, the unit of measure for pictures, and thumbnail files.
System Info: Displays information about your current picture, memory, disk space, and hardware.



Options Tool Options Command -- Changing Tool Settings

To adjust tool settings:    

If you are using a soft brush tool, adjust the options you want for soft brush tools.    

If you are using the Eyedropper tool, choose how you want to select a color.    

If you are using a Regular Polygon tool, choose the number of sides for the polygon.    

If you are using a tile pattern tool, choose how the tiles are pasted.    

You can keep the dialog box displayed and use the tool so you can experiment with the 
settings. You can also choose Close to close the dialog box and use the settings.

Related Topics:
PhotoFinish Tools



Options Tool Options Command -- Adjusting the Effect of Soft Brush Tools

To adjust the effect of soft brush tools:

1 Choose the settings you want for the specific tool.    

2 Choose OK.    

Related Topics:
Drawing Freehand with the Charcoal Tool
Painting Freehand
Replacing One Area with Another Freehand
Shading with the Airbrush
Smearing Colors Freehand



Soft Brush Settings Dialog Box Options

Edge

Density

Transparency

Fade Out

Spacing

Rate Of Flow

Rubber Stamp

Related Topics:
Adjusting the Effect of Soft Brush Tools
Brushing Freehand
Drawing Freehand with the Charcoal Tool
Replacing One Area with Another Freehand
Shading with the Airbrush
Smearing Colors Freehand



Options Brush Style Command -- Changing Your Brush Style

To change the brush style:    
1 Click the shape you want.

2 Click Set Size to change the tool width.    

3 Choose OK.    

Related Topics:
PhotoFinish Tools



Setting Your Tool Width

To set your tool width in the Set the Drawing Width dialog box:

1 Select a Units option.    
2 Use the Drawing width mini-scroll bar to change your tool width.
3 Choose OK.

Related Topics:
Changing Your Brush Style



Options Color Tolerance Command -- Specifying Color Tolerance

To specify colors to fill, replace, or select:

1 Type the color tolerance range for the colors to be filled.    

2 Choose OK.    

Related Topics:
Defining an Area of Similar Colors
Filling an Area with a Gradient
Filling an Area with a Tile Pattern
Filling an Area with Color
Replacing One Color with Another



Options Font More Fonts Command -- Adding Fonts to the Font List

To open a font:    
1 Choose the Font, Font Style, Size, and Effect you want.

2 Choose OK to add the font to the font list.    

Related Topics:
Adding Text to Your Picture
Selecting Fonts



Selecting Fonts

To select a font:
1 Select a font from the list of fonts.

2 Choose Font More Fonts to add Windows fonts to the font list.    

Related Topics:
Adding Text to Your Picture



Options Gradient Type Command -- Changing the Direction of Your Gradient

To change the gradient's effect:    

1 Select the gradient you want to use.    

2 Use the mini-scroll bar or type a number from 0 to 255 to select an amount of brightness.    
3 Choose OK.

Related Topics:
Changing Color Formats
Creating a Range of Colors
Filling an Area with a Gradient
Loading a Palette
Working with Different Numbers of Colors



Options Palette Color Picker Command -- Adjusting Individual Colors

To adjust the selected primary color:    

1 Select a color model from the Model drop-down list.    
2 Select a channel from the Channel drop-down list.

3 Adjust the selected channel level with the color slider.    
4 Choose Show Colors to see the available colors in the color refiner box.

5 Click on the color you want in the Color Refiner box.    

6 Choose OK.    

Related Topics:
Changing All the Colors in Your Palette
Changing Color Formats
Creating a New Color
Creating a Range of Colors
Loading a Palette
Mixing RGB Colors
Saving a Palette
Working with Different Numbers of Colors



Options Palette All Colors Command -- Changing All the Colors in Your Picture

To adjust the entire palette:    

1 Drag the Brightness and Contrast arrows to adjust the palette.    
2 Type a number from 0 to 360 in the Hue text box to select the color you want to "add" to your picture.   

3 Type a number from -100 to 100 in the Amount text box to select the amount of hue you want to add.   

4 Choose OK.    

Related Topics:
Changing Color Formats
Creating a New Color
Creating a Range of Colors
Loading a Palette
Saving a Palette
Working with Different Numbers of Colors



Options Palette Single Colors Command -- Creating a New Color

To change an individual color:    

1 Choose RGB or HLS as the color model you want to use to edit your color.    

2 Drag the arrows or type numbers in the text boxes to change the level of each color factor.    

3 Choose OK.    

Related Topics:
Adjusting Individual Colors
Changing All the Colors in Your Palette
Changing Color Formats
Creating a Range of Colors
Loading a Palette
Mixing RGB Colors
Saving a Palette
Working with Different Numbers of Colors



Options Palette Range of Colors Command -- Creating a Range of Colors

To create a range of colors:    

1 Choose RGB or HLS as the color model you want to use to edit your color.    
2 Click the left mouse button on the color you want to start the range.
3 Click the right mouse button on the color you want to end the range.
4 Use the mini-scroll bars or type numbers to change the level of each factor in the Start and End colors.   

5 Click Build Range.

6 Choose OK.    

Related Topics:
Adjusting Individual Colors
Changing All the Colors in Your Palette
Changing Color Formats
Creating a New Color
Loading a Palette
Mixing RGB Colors
Saving a Palette
Working with Different Numbers of Colors



Options Palette Open Palette Command -- Loading a Palette

To open a previously saved palette:    

1 Select the drive and directory you want.    

2 Click a file in the File Name list box.    

3 Choose OK.    

Related Topics:
Changing Color Formats
Saving a Palette
Selecting Tool Colors
Working with Different Numbers of Colors



Options Palette Save Palette As Command -- Saving a Palette

To save a palette:    

1 Select the drive and directory you want.    
2 Type a name for the palette in the File Name text box.
3 Choose OK.

Related Topics:
Changing Color Formats
Loading a Palette
Selecting Tool Colors
Working with Different Numbers of Colors



Mixing RGB Colors

Below is a list of RGB values for common colors. Color values are listed in the order you adjust them: 
Red, Green, and then Blue. Each value is separated by a comma.

To mix colors for a gray scale picture, first convert the picture to a 256 color or 24 bit color picture.

If the colors don't look right, you can adjust the brightness of your pictures on-screen with the Display 
Calibrate Monitor command.

Red
Dark: 85, 0, 0
Medium: 170, 0, 0
Bright: 255, 0, 0
Light: 255, 85, 85
Brick: 160, 64, 64
Cherry: 255, 0, 85
Maroon: 192, 0, 80
Pink: 255, 170, 170
Salmon: 255, 144, 128
Violet-Red: 255, 0, 170

Green
Dark: 0, 85, 0
Medium: 0, 170, 0
Bright: 0, 255, 0
Light: 170, 255, 170
Forest: 85, 170, 0
Grass: 0, 176, 112
Lime: 170, 255, 85
Olive: 120, 144, 0
Pine: 43, 85, 0
Sea Green: 170, 255, 255
Spring Green: 208, 255, 160
Yellow-Green: 192, 255, 0

Blue
Dark: 0, 0, 85
Medium: 0, 0, 170
Bright: 0, 0, 255
Light: 85, 85, 255
Baby Blue: 170, 170, 255
Blue-Gray: 144, 144, 160
Cobalt Blue: 96, 80, 208
Cornflower: 170, 170, 255
Navy: 0, 0, 128
Periwinkle: 224, 208, 255
Sky Blue: 85, 170, 255
Violet Blue: 170, 0, 255

Cyan (Blue-Green)
Dark: 0, 85, 85
Medium: 0, 170, 170



Bright: 0, 255, 255
Light: 85, 255, 255
Aquamarine: 160, 255, 224
Blue-Green: 0, 255, 170
Green-Blue: 0, 128, 112
Pale: 170, 255, 255
Turquoise: 0, 176, 160

Earthtones
Dark Brown: 128, 64, 0
Brown: 176, 80, 0
Burnt Sienna: 176, 64, 0
Copper: 176, 96, 64
Indian Red: 144, 0, 0
Mahogany: 192, 64, 0
Raw Sienna: 176, 96, 0
Raw Umber: 144, 96, 0
Rust: 160, 80, 48
Sepia: 144, 64, 0
Tan: 255, 144, 96

Flesh
Dark: 170, 85, 85
Medium: 255, 170, 170
Light: 255, 192, 192
Apricot: 255, 224, 192
Peach: 255, 208, 192

Gray
Black: 0, 0, 0
Very Dark: 64, 64, 64
Dark: 85, 85, 85
Medium: 128, 128, 128
Light: 170, 170, 170
Very Light: 213, 213, 213
White: 255, 255, 255
Silver: 208, 208, 224

Magenta (Red-Violet)
Dark: 85, 0, 85
Medium: 170, 0, 170
Bright: 255, 0, 255
Light: 255, 85, 255
Mulberry: 170, 0, 85
Orchid: 255, 85, 170
Pale: 255, 170, 255
Red Violet: 255, 0, 160

Orange
Dark: 128, 85, 0
Medium: 170, 113, 0
Bright: 255, 170, 0
Light: 255, 170,85
Bittersweet: 255, 112, 80
Burnt Orange: 224, 96, 0
Melon: 255, 128, 112



Orange-Red: 255, 80, 0
Tangerine: 255, 112, 0
Yellow-Orange: 255, 144, 0

Purple
Dark: 43, 0, 85
Medium: 85, 0, 170
Bright: 128, 0, 255
Light: 128, 85, 255
Violet: 96, 0, 112
Lavender: 213, 170, 255
Plum: 160, 0, 112

Yellow
Dark: 85, 85, 0
Medium: 170, 170, 0
Bright: 255, 255, 0
Light: 255, 255, 170
Amber: 255, 170, 0
Cream: 255, 255, 208
Gold: 176, 112, 64
Goldenrod: 255, 176, 0
Green-Yellow: 170, 255, 0
Lemon: 255, 255, 85
Maize: 255, 176, 112
Orange-Yellow: 255, 208, 0

Related Topics:
Changing All the Colors in Your Picture
Changing Color Formats
Creating a New Color
Creating a Range of Colors
Loading a Palette



Options Tile Pattern Command -- Opening a Tile Pattern

To open a tile pattern:

1 Select a File Type option.    

2 Select the drive and directory you want.    

3 Click a file in the File Name list box.    
4 Choose OK.

Related Topics:
Drawing a Line with a Tile Pattern
Filling an Area with a Tile Pattern
Previewing a Picture



Options Preferences Command -- Selecting Preferences

To change PhotoFinish settings:

1 Choose the options you want.    
2 Click Memory Options to set up or disable virtual memory.

3 Click VGA Palette to try to view more levels of gray.    
4 Choose OK.
5 Exit Windows and restart the program for the changes to take effect.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display



Preferences Dialog Box Options

At Startup

Units

Save Thumbnail Files

VGA Palette

Memory Options

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Selecting Memory Options
Selecting Preferences
Viewing More Levels of Gray



Viewing More Levels of Gray

To view more grays on a VGA monitor:
1 Save all work.

2 Choose Test Hardware.    
3 Choose Use VGA Hardware Palette if the test worked.
4 Choose OK. 

5 Exit Windows and restart PhotoFinish to make the VGA Hardware Palette option take effect.    

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Selecting Preferences



Selecting Memory Options

To set up virtual memory:

1 Select Enable Virtual Memory.    

2 Type a number in the Min KB text box.    

3 Type a number in the Max KB text box.    

4 Specify the Virtual Memory Path.    
5 Choose OK.
6 Exit Windows and restart PhotoFinish to make the Virtual Memory options take effect.

Related Topics:
Selecting Preferences



Displaying System Information

You use System Info command on the Help menu to view information about your current picture, your 
display, your printer, and your scanner. You can also see how much memory and disk space is installed 
and remains in your computer.

Image: Shows you the size, resolution, and number of colors in your picture.

Screen: Shows you the dpi your screen can display. The higher the number, the sharper your display.

Printer: Shows you the name of the currently selected printer and the dpi the printer can print. The higher 
the number, the sharper your printout will be. You can change the selected printer and printer 
settings with Print Setup.

Scanner: Shows you the name of the scanner you have installed to use with PhotoFinish.

Computer Memory: Shows you how much memory and disk space is installed in your computer and how 
much remains. You can set virtual memory paths with Preferences.

Related Topics:
Browsing Through Thumbnails
Previewing a Picture



The Window Menu

You use Window menu commands to rearrange PhotoFinish picture windows, rearrange minimized 
pictures, duplicate a picture, and change the active picture.

To choose a Window menu command, click Window and choose the command you want.

To change your active picture click the Window menu and choose a different picture from the picture list. 
For more information, see Activating a Picture Window.

Window Menu Commands
Cascade: Layers PhotoFinish picture windows so each title bar is visible.
Tile: Arranges PhotoFinish picture windows in equal sizes to fit on your screen.
Arrange Icons: Arranges minimized pictures across the bottom of the PhotoFinish desktop.
Duplicate: Duplicates pictures so you can see changes at different magnifications while you edit a picture.



Window Cascade Command -- Cascading Your Picture Windows

To layer your picture windows:

Choose Cascade from the Window menu.    

Related Topics:
Activating a Picture Window
Tiling Your Picture Windows



Window Tile Command -- Tiling Your Picture Windows

To arrange your picture windows:

Choose Tile from the Window menu.    

Related Topics:
Activating a Picture Window
Cascading Your Picture Windows



Window Arrange Icons Command -- Arranging Your Picture Icons

To arrange picture icons:

Choose Arrange Icons from the Window menu.    



Activating a Picture Window

To activate a picture:

Click the name of the picture on the Window menu picture list or click the title bar of the 
picture.

A check mark appears beside the picture name on the Window menu list to show it is 
selected.



Window Duplicate Command -- Viewing a Picture in Multiple Views

To duplicate a picture:    

Choose Duplicate from the Window menu.    

Related Topics:
Viewing the Same Area in Multiple Windows
Zooming In and Out with the Zoom Commands
Zooming In or Out with the Zoom Tool



The Control Menu

You use Control menu commands on the PhotoFinish program and picture windows to move, close, 
restore, and change the size of the window. These commands are standard Windows commands.

You use Control menu commands on the PhotoFinish workboxes to move and hide the workboxes. The 
Toolbox workbox Control menu also has the Layout command, and the Palette workbox Control menu 
also has the Fold/Unfold command.

Point to a topic below and click on it for more information about the Control menu commands unique to 
PhotoFinish.

Control Menu Commands
Image Info: Displays information about the picture.
Resolution: Changes the resolution of the picture.
Layout: Allows you to change the width and height of the Toolbox and to group or ungroup the tools.
Fold/Unfold: Allows you to fold or unfold the Palette workbox.



Layout Command -- Laying Out the Toolbox

To change your Toolbox layout:
1 Click the Control menu box on the Toolbox.

2 Choose Layout Ungroup or Layout Group.    

3 Choose a column or row command to lay out your Toolbox.    

Related Topics:
Finding and Selecting Tools
Showing or Hiding Workboxes
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape workbox



Fold/Unfold Command -- Folding and Unfolding the Palette

To fold or unfold your Palette:
1 Click the Control menu box of the Palette.

2 Choose Fold or Unfold.    

Unfold displays all the colors or settings available in your Palette.    

Fold displays only the color selection box.

Related Topics:
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape workbox
Showing or Hiding Workboxes
Selecting Tool Colors
Selecting Tool Settings



The Scan Menu

You use Scan menu commands to load and save scanner configurations, calibrate your scanner, scan 
and set scanning options, stitch images together, and rescan images.

To choose a Scan menu command, click Scan and choose the command.

Scan Menu Commands
AutoScan: Automatically scans and improves the quality of an image.
Scan: Changes scanner settings and scans or captures an image.
Scan Again: Scans or captures an image again with the current settings.
Stitch: Scans an image and adds it to the active picture.
Calibrate Scanner: Calibrate your scanner, create, edit, or delete calibration maps.
Open Configuration: Loads scanner settings previously saved to disk.
Save Configuration As: Saves scanner settings to disk.



Scan AutoScan Command -- Improving the Quality of a Scanned Image

To have PhotoFinish automatically scan and correct your image:    

1 Choose Options to select the auto enhancement options.    

2 Click the Scan button to scan and automatically enhance the picture, and then choose OK.    
3 Choose Accept to load the enhanced image into a new picture window.

Related Topics:
Adjusting Brightness and Contrast
Changing Your AutoScan Options
Cropping Your Picture
Removing Moiré Patterns from Your Scanned Image



Changing Your AutoScan Options

To specify auto enhancement options:

1 Click the box next to the option you want PhotoFinish to use on your picture.    

2 Select an image type from the Image Type drop-down list.    

3 Choose the output device you want from the Output drop-down list.    

4 Click Edit Output to view, change, add, or delete available Output options.    
5 Choose OK to use your new selections.

Related Topics:
Adjusting Brightness and Contrast
Changing Your Highlights and Shadows
Cleaning Up a Scanned Image
Cropping Your Picture
Improving the Quality of a Scanned Image
Removing Moiré Patterns from Your Image



Changing Your Output Device

To change, add, or delete output options:
1 Use the mini-scroll bars to adjust the Vertical and Horizontal resolution for Text/Line Art and Photo 

scanning.    

2 Choose Change to save your settings with the selected Output name.    
3 Choose Close when you are finished making your changes.

Related Topics:
Changing Your AutoScan Options
Improving the Quality of a Scanned Image



Scan Scan Command -- Scanning a Picture

You use the Scan command on the Scan menu to scan or capture an image. The dialog box that appears 
when you choose Scan Scan differs depending on the type of scanner you are using. Click the Related 
Topic for your scanner for step-by-step instructions.

If your scanner is installed for the TWAIN standard interface, you can also select a TWAIN source and 
click Acquire from the File menu to scan an image.

Related Topics:
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber



Scanning with a Flatbed Scanner

If you plan to stitch, be sure to scan the left side of the image first.

To scan with a flatbed scanner:    
1 Click Options to change scanner settings and choose OK.

2 Adjust other options you want.    

3 Click Prescan to prescan the image.    

4 Click Scan to scan your picture.    

Related Topics:
Loading Scanner Settings
Saving a Picture with a New Name
Saving Scanner Settings
Scanning with PhotoFinish



Flatbed Scanner Dialog Box Options

Units

Margins

Set Paper Size

Prescan

Select Scan Area box

Options

Scan

Related Topics:
Loading Scanner Settings
Saving Scanner Settings
Scanning Different Page Sizes
Scanning with a Flatbed Scanner
Scanning with PhotoFinish
Setting Up Scanning Options



Scanning with a Video Grabber

If you plan to stitch, be sure to capture the left side first.

To capture an image with a video grabber:    
1 Click Options to change grabber settings and choose OK.

2 Adjust other options you want.    

3 Click Prescan to prescan the area.    
4 Click Stop to end prescanning.

5 Click Capture to capture the area you want.    

Related Topics:
Loading Scanner Settings
Saving a Picture with a New Name
Saving Scanner Settings
Scanning with PhotoFinish
Stitching Scanned Images



Video Grabber Dialog Box Options

Scan Area

Set Dimensions

Prescan

Select Video Scan Area box

Brightness

Contrast

Options

Capture

Related Topics:
Capturing Different Picture Sizes
Loading Scanner Settings
Saving Scanner Settings
Scanning with a Video Grabber
Scanning with PhotoFinish
Setting Up Scanning Options



Scanning with a Hand Scanner

If you plan to stitch, be sure to scan the left side first.

To scan with a hand scanner:    
1 Click Options to change scanner settings and choose OK.

2 Adjust other options you want.    
3 Click Scan and begin to scan with the hand scanner.

4 Click Scan to scan your picture.    

Related Topics:
Loading Scanner Settings
Saving a Picture with a New Name
Saving Scanner Settings
Scanning with PhotoFinish
Stitching Scanned Images



Hand Scanner Dialog Box Options

Units

Margins

Set Scan Size

Feedback

Hand Scanner Area

Options

Scan

Related Topics:
Handscanning Different Page Sizes
Loading Scanner Settings
Saving Scanner Settings
Scanning with a Hand Scanner
Scanning with PhotoFinish
Setting Up Scanning Options



Setting Up Scanning Options

To adjust scanner options:

1 Adjust the options you want.    
2 Choose OK to return to the main scanning dialog box.

Related Topics:
Loading Scanner Settings
Saving Scanner Settings
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish
Working with Different Numbers of Colors



Scanner Setup Dialog Box Options

Brightness

Contrast

Scaling

Image Type

Halftone

Resolution

Enhancements

Units

Related Topics:
Scanning with PhotoFinish
Setting Up Scanning Options



Scanning Different Page Sizes

To change your paper size:

1 Select a Units option.    

2 Select a paper size option.    
3 Click OK to return to the main scanning dialog box.

Related Topics:
Scanning with a Flatbed Scanner
Scanning with PhotoFinish



Flatbed Scanner Page Size Options

Letter

Legal

Custom

B Size

A3

A4

A5

B5

Related Topics:
Scanning Different Page Sizes
Scanning with a Flatbed Scanner



Capturing Different Picture Sizes

To change scan dimension size:

1 Type the unit of measure you want.    
2 Type a horizontal and vertical size of the area you want to capture.
3 Click OK to return to the main scanning dialog box.

Related Topics:
Scanning with a Video Grabber
Scanning with PhotoFinish



Handscanning Different Page Sizes

To change the scan area size:

1 Select a Units option.    

2 Type the width of the area you want to scan in the Horizontal Size text box.    
3 Type the length of the area you want to scan in the Vertical Size text box.
4 Click OK to return to the main scanning dialog box.

Related Topics:
Scanning with a Hand Scanner
Scanning with PhotoFinish



Scan Scan Again Command -- Rescanning a Picture

To rescan a picture:    
1 Choose Yes to rescan or recapture your picture with the current settings.
2 Choose No to cancel the scan.

Related Topics:
Loading Scanner Settings
Scanning a Picture
Scanning with PhotoFinish
Stitching Scanned Images



Scan Calibrate Scanner Command -- Calibrating Your Scanner

To load a preset map:    

1 Choose the map you want from the Preset Maps drop-down list.    
2 Choose OK to use the map.

3 You can choose Options to create a new map, recalibrate, edit, or delete the selected map.    

Related Topics:
Calibrating Your Devices
Creating a New Scanner Calibration Map
Editing a Scanner Calibration Map
Loading Scanner Settings
Scanning a Picture
Scanning with PhotoFinish
Stitching Scanned Images



Recalibrating Your Scanner

To recalibrate your monitor:
1 Place the calibration card on your scanner.

2 Select which option you want your scanner to be calibrated for, and choose OK.    
3 Choose OK to save your changes to disk and use your new settings.

Related Topics:
Calibrating Your Devices
Creating a New Scanner Calibration Map
Editing a Scanner Calibration Map



Creating a New Scanner Calibration Map

To create a new calibration map:
1 Choose a preset map that the new map is to be based on from the Based On drop-down list.
2 Type a name for the new calibration map in the File Name text box.
3 Choose OK save the map to disk.
4 Click Recalibrate to recalibrate your monitor and save it to the new map.
5 Click Edit to fine-tune the map.

Related Topics:
Calibrating Your Devices
Calibrating Your Scanner
Editing a Scanner Calibration Map
Loading Scanner Settings
Scanning a Picture
Scanning with PhotoFinish
Stitching Scanned Images



Editing a Scanner Calibration Map

To edit a scanner calibration map:    

1 Choose a channel to specify the colors to be adjusted.    

2 Adjust the curve to get the effect you want.    

3 Choose OK to save your changes to disk and use your map.    

Related Topics:
Calibrating Your Devices
Calibrating Your Scanner
Creating a New Scanner Calibration Map
Editing a Scanner Calibration Map
Loading Scanner Settings
Scanning a Picture
Scanning with PhotoFinish
Stitching Scanned Images



Compensation Map Editing Options

You can use several styles to get the response curve you want.

Curve

Freehand

Linear

This picture illustrates the color values represented in the calibration map sample box:

Related Topics:
Calibrating Your Devices
Scanning a Picture
Stitching Scanned Images
Scanning with PhotoFinish



Scan Stitch Command -- Stitching Scanned Images

To scan an image larger than the width of your scanner:

1 Use Scan to scan the left side of your picture.    

2 Choose Stitch from the Scan menu.    

3 Scan the portion of the image you want to add.    

4 Move the stitched image where you want it.    
5 Choose another command, select a tool, or choose Select None to stitch the image permanently.

Related Topics:
Manipulating Defined Areas
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish
Zooming In and Out with the Zoom Commands



Scan Open Configuration Command -- Loading Scanner Settings

To load previously saved scanner settings:

1 Select the drive and directory you want.    
2 Click a scanner configuration in the File Name list box.
3 Choose OK.

Related Topics:
Rescanning a Picture
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish



Scan Save Configuration As Command -- Saving Scanner Settings

To save scanner settings:

1 Select where you want to save the file.    
2 Type a name for the file.
3 Choose OK.

Related Topics:
Loading Scanner Settings
Scanning with PhotoFinish
Setting Up Scanning Options



Scanning with PhotoFinish

You use a scanner to translate a printed image to computer language so you can use the image with your
computer. You can use flatbed scanners, video grabbers, and hand scanners with PhotoFinish.

Keep the following in mind when you scan with PhotoFinish:

You must first connect your scanner to your computer system according to the scanner 
manufacturer's installation instructions.

If you want to use PhotoFinish's scanning features, you must first install and configure 
your scanner with the PhotoFinish setup program.

Turn on your scanner before you start PhotoFinish.

If you have already installed PhotoFinish and want to install a scanner, run the 
PhotoFinish Setup program again and choose the Install PhotoFinish, Scanners, or Additional Files 
options. You will be prompted to insert PhotoFinish diskettes or scanner manufacturer's diskettes to install
your scanner.

If you want to reconfigure a previously installed scanner, run the PhotoFinish Setup 
program again and choose the Reconfigure a Previously Installed Scanner option.

If your scanner supports the TWAIN interface, use the Select Source and Acquire 
commands on the File menu to set up your scanner and to scan.

Related Topics:
Improving the Quality of a Scanned Image
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber



Viewing Colors on Your Screen

PhotoFinish provides device independence so you can load and edit images that have more colors than 
your monitor supports. PhotoFinish simulates colors not supported by your monitor and retains all the 
original details and colors in your picture.

To adjust how bright your pictures appear on-screen, see Calibrate Monitor.

To enhance how simulated colors appear on-screen, see Optimize Display.

If your VGA driver supports fewer than 16 levels of gray, you may be able to use 
PhotoFinish's VGA Hardware Palette option to improve the on-screen appearance of gray scale pictures. 
For more information see Viewing More Levels of Gray.

Related Topics:
Working with Different Numbers of Colors



Working with Different Numbers of Colors

PhotoFinish supports 24 bit color, 256 color, gray scale, and black and white pictures. A picture with fewer
than 256 colors or grays is automatically converted to 256 color when you open it. A 32 bit picture is 
automatically converted to 24 bit color when you open it.

You can create and edit pictures that contain more colors than your hardware supports without losing 
original detail. PhotoFinish simulates colors on-screen that your monitor doesn't support, giving you 
device independence.

Following is general information about working with pictures. For more specific color information, click one
of the Related Topics.

Use Convert To to convert a picture to another color format. If you plan to use the picture 
with a device or application that requires a specific format, you can convert the picture, edit it, and then 
convert it to the format you need.

To optimize how PhotoFinish simulates colors on-screen, see Optimize Display.

To adjust how bright your pictures appear on-screen, see Calibrate Monitor.

Filter, Special Effect, and Tune commands work best with 24 bit color and gray scale 
pictures. For more information, see Using Filter Commands, Using Tune Commands, or Using Special 
Effect Commands.

Retouch tools work best with 24 bit color and gray scale pictures.

Some commands and tools are available only with 24 bit color or gray scale pictures. 
Commands that are unavailable for the format you are using are dimmed and cannot be selected. When 
you try to use a tool that is unavailable for the format you are using, you receive an error message.

Related Topics:
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Gray Scale Pictures



Working with Black and White Pictures

A black and white picture is made up of only black and white. Grays are made up of individual dots of 
black and white. This mode is useful if you want high contrast black and white pictures.

You can create, open, save, scan, and edit black and white pictures with PhotoFinish.

If you convert a picture to black and white, you can choose a conversion type. 

If you want to colorize a black and white picture or take advantage of more options and 
tools, you can convert the picture to another color format.

Black and white requires the least amount of memory.

The following tools are not available for black and white pictures: Airbrush, Color 
Replacer, Paintbrush, Charcoal, Contrast Paintbrush, Brighten Paintbrush, Tint Paintbrush, Blend 
Paintbrush, Smear Paintbrush, and Sharpen Paintbrush.

The only available Filter command is Remove Spots.

The only available Special Effect command is Outline.

The only available Tune command is Negative.

You can open black and white pictures in the following formats: BMP, GIF, JPEG, MSP, 
PCX, and TIFF.

You can save black and white pictures in the following formats: BMP, EPS, GIF, JPEG, 
PCX, and TIFF.

Related Topics:
Working with Different Numbers of Colors



Working with Gray Scale Pictures

A gray scale picture is made up of 256 solid grays. This mode is useful if you do not want to add color to 
your picture.

You can create, open, save, scan, and edit gray scale pictures with PhotoFinish. Grays not supported by 
your monitor are simulated on-screen, and the original detail is retained in your picture.

When you convert a gray scale picture to color, the picture remains gray, but you can add
colors.

If you use a VGA driver that displays fewer than 16 levels of gray, you may be able to use
PhotoFinish's VGA Hardware Palette option to increase the number of grays displayed on-screen.

All Filter, Tune, and Special Effect commands and tools are available with the exception 
of Tune Hue and Saturation.

Gray scale pictures require less memory than 24 bit color pictures.

You can open gray scale pictures in the following formats: BMP, GIF, JPEG, PCX, 
TARGA, and TIFF.

You can save gray scale pictures in the following formats: BMP, EPS, GIF, JPEG, PCX, 
TARGA, and TIFF.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Working with Different Numbers of Colors



Working with 256 Color Pictures

A 256 color picture is made up of 256 solid colors. This mode is useful if you are creating pictures to view 
on-screen or if you don't have enough memory for 24 bit color pictures. PhotoFinish automatically 
converts a picture with fewer than 256 colors to 256 color when you open it.

You can create, open, save, scan, and edit 256 color pictures with PhotoFinish. Colors not supported by 
your monitor are simulated on-screen and the original detail is retained in your picture.

The color set in the palette of a 256 color picture defines the colors available for your 
picture.

You can use Palette commands to adjust a single color, range of colors, or all the colors 
in your palette. However, the picture will also change.

The following tools are not available for 256 color pictures: Paintbrush, Airbrush, Blend 
Paintbrush, Charcoal, Tint Paintbrush Sharpen Paintbrush, and Smear Paintbrush.

Rubber Stamp is the only Tool Options setting available with 256 color pictures.

Diffuse and Remove Spots are the only Filter commands available for 256 color.

Black Hole, Crystallize, Fisheye Lens, Outline, and Twist are the only Special Effect 
commands available for 256 color picture.

All Tune commands are available for 256 color pictures with the exception of Hue and 
Saturation.

You can open 256 color pictures in the following formats: BMP, GIF, PCX, TARGA, and 
TIFF.

You can save 256 color pictures in the following formats: BMP, EPS, GIF, PCX, TARGA, 
and TIFF.

To take advantage of all the Filter, Tune, and Special Effect commands and tools, speed 
up the retouch tools' response time, and use other color options unavailable for 256 color pictures, use 
Convert To to convert your picture to 24 bit color.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Working with Different Numbers of Colors



Working with 24 Bit Color Pictures

A 24 bit color picture is made up of 16,777,216 colors, providing better detail and depth than other color 
modes. Retouch tools and the commands on the Image menu also work best in 24 bit color mode. You 
can paste pictures without changing their colors.

You can create, open, save, scan, and edit 24 bit color pictures with PhotoFinish. Colors not supported by
your monitor are simulated on-screen, and the original detail is retained in your picture.

The color set in the Palette of a 24 bit color picture displays 256 of the 16.7 million colors 
available.

To change the colors displayed in the color set for easy access: double-click a color in the
palette; use any of the Palette commands, or pick up a color from your picture with the Eyedropper.

You can use the Optimize Display command to change the look of 24 bit color pictures 
on-screen.

All of the Filter, Tune, and Special Effect commands and tools are available with 24 bit 
color pictures.

You can open 24 bit color pictures in the following formats: BMP, JPEG, PCX, TARGA, 
and TIFF.

You can save 24 bit color pictures in the following formats: BMP, EPS, JPEG, PCX, 
TARGA, and TIFF.

To use your picture with a device or application that does not support 24 bit color, use 
Convert To to convert the picture to the color mode you need.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Working with Different Numbers of Colors



Calibrating Your Devices

Differences between your scanner, printer, and monitor can occur for many reasons. Your picture may 
appear darker in print than it does on-screen because printer dots look darker and larger than the dots on 
your screen. In addition, colors on a monitor are projected and so they usually appear brighter than 
printed colors, which are perceived with reflective light. And each device also has its own idiosyncrasies. 
For example, your scanner may tend toward the dark end of the spectrum or your printer may print dark 
because it is new. Even the length of time a device is on can change its results. For example, a scanner 
usually gives you different results when you first turn it on and after it is warm. Compensating your 
devices helps you to get the results you expect.

PhotoFinish uses special response curves, called compensation maps, to adjust your devices. 
Compensation maps do not change the colors in your picture. Instead, the colors in your picture are 
adjusted when the picture is sent to or from the device. For example, a printer compensation map is 
applied to a picture when the picture is sent to your printer.

You can load a preset map, let PhotoFinish automatically recalibrate a map for you, create a new map 
based on a previous one, and fine-tune a map.

Following is an explanation of which type of calibration method you should use.

You can choose a preset map for your scanner, printer, and monitor. Although this is not 
the most accurate way to adjust your devices, it is a quick way to get started. You cannot recalibrate, edit, 
or delete a preset map shipped with PhotoFinish.

Generally, you load a preset map you previously calibrated or fine-tuned. If, however, you
want to get started right away or a particular device does not support PhotoFinish's automatic calibration, 
you can load one of the preset maps PhotoFinish supplies.

If your monitor can display at least 256 colors or 16 levels of gray, you can let 
PhotoFinish recalibrate a map specifically for you.

If you have a flatbed, sheetfed, or hand scanner that is at least four inches wide, supports
256 gray scale or 24 bit color, and has a resolution of at least 75 dpi, installed in PhotoFinish, you can let 
PhotoFinish recalibrate a map specifically for your scanner.

If you have a printer installed in Windows and a scanner that supports the scanner 
requirements listed above, you can let PhotoFinish recalibrate a map specifically for your printer.

For step-by-step instructions on calibrating a device, choose one of the topics below.

Calibrate Scanner
Calibrate Monitor
Calibrate Printer



Retouching and Enhancing Pictures

Adding a Mosaic Effect to Your Image
Adding Facets to Your Picture
Adding Texture to Your Picture
Adjusting Hue and Saturation
Adjusting Individual Colors
Adjusting Soft Brushes
Applying the Fisheye Effect
Applying the Maximum Filter
Applying the Minimum Filter
Blending Freehand
Blending with the Blend Filter
Blurring Your Picture
Brightening Freehand
Brushing Freehand
Changing All the Colors in Your Picture
Changing Contrast Freehand
Changing the Direction of Your Gradient
Changing Your Highlights and Shadows
Cleaning Up a Scanned Image
Creating a Motion Effect in Your Picture
Creating a New Color
Creating a Range of Colors
Crystallizing Your Picture
Diffusing Your Picture
Drawing a Line with a Tile Pattern
Drawing Freehand with the Charcoal Tool
Embossing Your Picture
Enhancing Edges
Filling an Area with a Gradient
Filling an Area with a Tile Pattern
Fine-Tuning with the Color/Gray Map 
Improving the Quality of a Scanned Image
Inverting Colors in Your Picture
Pixelating Your Picture
Posterizing Your Picture
Removing Moiré Patterns from Your Image
Replacing One Area with Another Freehand
Resizing Freehand
Resizing Your Picture
Rotating by Degrees
Saving Response Curve Settings
Selecting Tool Colors
Selecting Tool Settings
Setting Your Tool Width
Shading with the Airbrush
Sharpening Freehand
Sharpening with the Sharpen Filter
Smearing Colors Freehand
Smudging Freehand
Tinting Freehand
Twisting Your Picture



Using Filter Commands
Using Special Effect Commands
Using Tune Commands

Related Topics:
Editing a Picture
Glossary Terms
Painting with PhotoFinish
PhotoFinish Tools



Editing a Picture

Adding Fonts to the Font List
Adding Text to Your Picture
Adjusting Soft Brushes
Brushing Freehand
Copying to the Clipboard
Cropping Your Picture
Cutting to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining an Area of Similar Colors
Deleting Portions of Your Picture
Drawing a Filled Equal-sided Polygon
Drawing a Hollow Equal-sided Polygon
Drawing a Line with a Tile Pattern
Editing Your Picture Full Screen
Erasing Parts of Your Picture
Exiting and Returning to the Destination Application
For Beginners
Inverting Colors in Your Picture
Making a Mirror Image
Manipulating Defined Areas
Moving Areas of Your Picture into View
Opening an Existing Picture
Outlining Shapes in Your Picture
Pasting from Disk
Pasting from the Clipboard
Restoring Your Previous Version
Saving Portions of Your Picture to Disk
Selecting Fonts
Setting Your Tool Width
Shading with the Airbrush
Smearing Colors Freehand
Starting a New Picture
Turning Your Picture Upside Down
Undoing Changes to Your Picture
Undoing Some Changes
Updating an Embedded Picture
Using Filter Commands
Using Special Effect Commands
Using Tune Commands
Viewing a Picture in Multiple Views
Viewing the Same Area in Multiple Windows
Working with Embedded Pictures
Zooming In and Out with the Zoom Commands
Zooming In and Out with the Zoom Tool
Zooming to Fit

Related Topics:
Glossary Terms
Painting with PhotoFinish



PhotoFinish Tools
Retouching and Enhancing Pictures



Printing

Adjusting Picture Resolution
Calibrating Your Devices
Compensation Map Editing Options
Creating a New Printer Calibration Map
Editing a Printer Calibration Map
Printing a Picture
Selecting Preferences
Setting Up Your Printer

Related Topics:
Glossary Terms



Painting with PhotoFinish

Adjusting Soft Brushes
Brushing Freehand
Changing Your Brush Style
Changing Your Tool Width and Shape
Drawing a Filled Box
Drawing a Filled Ellipse/Circle
Drawing a Filled Equal-sided Polygon
Drawing a Filled Polygon
Drawing a Filled Rounded Box
Drawing a Hollow Box
Drawing a Hollow Ellipse/Circle
Drawing a Hollow Equal-sided Polygon
Drawing a Hollow Polygon
Drawing a Hollow Rounded Box
Drawing a Line with a Tile Pattern
Drawing Freehand Shapes
Drawing Single and Joined Curves
Drawing Single and Joined Lines
Erasing Parts of Your Picture
Filling an Area with a Gradient
Filling an Area with a Tile Pattern
Filling an Area with Color
Finding and Selecting Tools
Laying Out the Toolbox
Moving Areas of Your Picture into View
Opening a Tile Pattern
Picking Up a Color from the Screen
Replacing One Area with Another Freehand
Replacing One Color with Another
Selecting Tool Colors
Selecting Tool Settings
Setting Your Tool Width
Shading with the Airbrush
Smearing Colors Freehand
Smudging Freehand
Specifying Color Tolerance
Splattering Color with the Spraycan
Viewing the Same Area in Multiple Windows
Working with Embedded Pictures

Related Topics:
Editing a Picture
Glossary Terms
PhotoFinish Tools
Retouching and Enhancing Pictures



Working with Colors

Adjusting Individual Colors
Calibrating Your Devices
Changing All the Colors in Your Picture
Changing Color Formats
Changing the Direction of Your Gradient
Clearing Your Picture to the Background Color
Creating a New Color
Creating a Range of Colors
Inverting Colors in Your Picture
Loading a Palette
Mixing RGB Colors
Optimizing Your Display
Picking Up a Color from the Screen
Replacing One Color with Another
Saving a Palette
Selecting Tool Colors
Selecting Tool Settings
Shading with the Airbrush
Smearing Colors Freehand
Specifying Color Tolerance
Tinting Freehand
Viewing Colors on Your Screen
Viewing More Levels of Gray
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Different Numbers of Colors
Working with Gray Scale Pictures

Related Topics:
Glossary Terms



Scanning

Acquiring an Image with a TWAIN Device
Calibrating Your Devices
Capturing Different Picture Sizes
Hand Scanning Different Page Sizes
Loading Scanner Settings
Rescanning a Picture
Saving Scanner Settings
Scanning Different Page Sizes
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish
Selecting a TWAIN Source
Setting Up Scanning Options
Stitching Scanned Images

Related Topics:
Glossary Terms
Retouching and Enhancing Pictures



Working with Files

Changing Color Formats
Closing a Picture
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Displaying Picture Information
Loading a Palette
Loading Scanner Settings
Moving Picture Files with the Viewer
Opening a Tile Pattern
Opening an Existing Picture
Previewing a Picture
Renaming Picture Files with the Viewer
Saving a Palette
Saving a Picture with a New Name
Saving a Picture with Save
Saving Response Curve Settings
Saving Scanner Settings
Selecting Preferences
Starting a New Picture
Viewing Pictures
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Gray Scale Pictures
Updating an Embedded Picture

Related Topics:
Glossary Terms
Working with Windows



Working with Windows

Acquiring an Image with a TWAIN Device
Activating a Picture Window
Arranging Your Picture Icons
Cascading Your Picture Windows
Closing a Picture
Displaying System Information
Editing Your Picture Full Screen
Exiting and Returning to the Destination Application
Exiting PhotoFinish
Folding and Unfolding the Palette
Laying Out the Toolbox
Opening an Existing Picture
PhotoFinish Shortcuts
Scrolling
Selecting a TWAIN Source
Selecting Memory Options
Selecting Preferences
Showing or Hiding the Palette
Showing or Hiding the Toolbox
Showing or Hiding the Width & Shape workbox
Showing or Hiding Workboxes
Tiling Your Picture Windows
Updating an Embedded Picture
Using PhotoFinish Windows
Viewing a Picture in Multiple Views
Viewing Only Your Picture
Viewing the Same Area in Multiple Windows
Viewing Your Picture with No Zoom
Working with Embedded Pictures

Related Topics:
For Beginners
Glossary Terms



PhotoFinish Utilities

PhotoFinish has utilities you use to view information about .PCX and .TIF files, to view information about 
your computer, and to capture areas of your screen.

See the Reference section of your PhotoFinish User's Guide for more about these utilities.

Utilities
CHKALL: Allows you to check information about hardware, memory, and some software present in your 

computer system. This is a DOS utility you use at the DOS prompt.
PCXHDR: Allows you to view header information about .PCX files and turn off a palette in a .PCX file. 

This is a DOS utility you can use from the Windows environment.
TIFFDUMP: Allows you to view information about .TIF files. This is a DOS utility you can use from the 

Windows environment.
ZCapture: Takes over your Windows screen capture functions so you can capture areas of your screen 

and keep your colors intact.



Choose Clipboard to load the contents of the Clipboard.



Click Info to preview and read information about the picture.

Click Viewer to browse through pictures saved to disk or to manage your picture files.



Click Info to preview and read information about the picture.



Choose Yes to save changes.

Choose No to cancel changes.

Choose Cancel to continue working.



The cutout is replaced by the background color.



If you paste into a 256 color or gray scale picture and the cutout contains colors not 
included in the palette, the cutout's colors change.

The cutout's colors do not change if you first convert the picture to 24 bit color or load a 
more compatible palette.



The cutout appears in the upper left corner of your picture, enclosed by the marquee.



You can manipulate a cutout until you paste it.

You can also use the arrow keys to move a cutout one pixel at a time.



Use Copy to store a defined area on the Clipboard without cutting it from the picture.

Use Cut to cut and store a defined area on the Clipboard.

Use Delete to delete a defined area and preserve the contents of the Clipboard.



Do not choose the .EPS format until you finish making changes to your picture.

If you choose the .JPG format, your picture will lose some detail.



If you choose the PCX format and the active picture is 256 color or gray scale, you can 
select 16 Color from the Subformat drop-down list to save with 16 colors.

If you open the picture again, Photo Finish converts the picture to 256 colors.

Use File Save As to save the picture again in 16 colors.

If you choose Custom for the JPEG format, a dialog box appears when you choose OK 
so you can select settings.



You can use this command or tool with gray scale and 24 bit color pictures.

Use Convert To to change the color mode if this command or tool is not available.



You can use this command or tool with gray scale and 24 bit color pictures.

Use Convert To to change the color mode if this command or tool is not available.

You can use this command if you have a flatbed scanner that supports 256 gray scale or 
24 bit color.

For other scanners, use the Scan Scan command to scan your image, then use the Scan 
AutoScan command to enhance your image.



You can use this command or tool with gray scale, 256 color, and 24 bit color pictures.

Use Convert To to change the color mode if this command or tool is not available.



The higher the number, the greater the effect.



Choose Preview to see how changes may alter your picture.



Some blending occurs each time you apply Image Transform Rotate. To keep your 
picture from being over-blended, choose Edit Undo before you adjust the amount of rotation and choose 
Transform Rotate again.



To display a workbox, choose the appropriate command in the Display menu.

To quickly display the Toolbox workbox, press Ctrl+T.

To quickly display the Width & Shape workbox, press Ctrl+W.

To quickly display the Palette workbox, press Ctrl+P.



The area you click centers in the picture window.



To see changes occur in other zoom views, duplicate the picture and adjust the zoom 
levels. Use the Locator tool to display the same area in all copies.



Use the Locator tool to quickly display the same area in all windows that contain the 
same duplicates.



Click the left mouse button to choose the primary color.

Click the right mouse button to choose the secondary color.

Hold down Shift and click the left mouse button to choose the background color.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.



You can drag the marquee to move the cutout. You can use the Image and Edit menu 
commands to manipulate the defined area.



Use Undo to cancel all changes made since the last time you chose a tool or command.

Use Local Undo to cancel only some changes made since the last time you chose a tool 
or command.

Use Revert to undo all changes made since the last time you saved the picture.

Use Clear to replace the current picture with the selected background color.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.



Completely enclose the area you are filling or the color "leaks out." If this happens, 
choose Undo and zoom in to fix any "holes" in the border.

You may have to adjust color tolerance to control color leaking.



The primary color is used for the border of hollow or filled shapes.

The secondary color is used inside filled shapes.



Click the shape button in the Width & Shape workbox to quickly change the shape.

Type a number or use the mini-scroll bar in the Width & Shape workbox to change the 
tool's size.

If you want a filled shape without a border, set the width to 0.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.



To draw joined curves or lines, draw your first curve or line. (Do not paste the curve.) 
Point to where you want the second curve or line to end and click the right mouse button.

To draw rays joined at a single point, draw the first curve or line. (Do not paste the curve.)
Point to where you want the second curve or line to end, hold down Ctrl, and click the right mouse button.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.



Hold down Shift while you drag to constrain the tool to a circle.

To draw concentric ellipses or circles, draw the largest ellipse or circle first. Then, press 
the right mouse button and drag to draw the others.



Hold down Shift while you drag to constrain the tool vertically or horizontally.

To change the level of the effect, select a different level from the Palette.

Repeated brushes have no effect unless you save the changes. To save the changes, 
click the tool and brush again.



The secondary color begins gradients.

The background color ends gradients.

To create a smoother gradient in 256 color pictures, use Palette Range of Colors or load 
another palette and adjust your colors so they have the same hue.

You can also convert your picture to 24 bit color to get smoother gradients.



Use the Box Selection, Magic Wand, Lasso, Elliptical Selection, or Scissors to define an 
area.



The farther the number is from 0, the greater the effect.

You can also click in the slider bars or drag the slider bar arrows to adjust the brightness 
and contrast.

As a rule of thumb, increase contrast about one tenth the amount you increase 
brightness.



The arrows point to the location of the light source and determine the angle of the 
highlights and shadows.



The color you choose determines the overall color of your embossed image.

For best results, choose a medium grayish color. 



Default settings generally provide good results.

Shades to the left of the Low arrow are black.

Shades to the right of the High arrow are white.

Highlights are the shades between the High and Mid values.

Shadows are the shades between the Low and Mid values.

Choose Restore to return to the original values.



The larger the spot size, the more time is required for the filter to work.



The converted picture is loaded into a window named NEW followed by a number.

Use Save As to save the converted picture.



Colors are reversed as if on a photographic negative.



You can create gray scale, 256 color, 24 bit color, and black and white pictures.



Type numbers in the boxes or use the mini-scroll bars to set the size.

The dialog box indicates how much memory is needed for the picture and how much 
remains.



The picture's name appears on the picture's title bar and the Window menu and File 
menu picture lists.

You can open up to 8 pictures at one time.



Information includes the picture's name, the last time the picture was saved, height and 
width in pixels, number of colors, file size, image size, format, and type of compression used, if any.



If you have selected Keep Thumbnail Files in Preferences, PhotoFinish displays the small
picture more quickly the next time you preview the picture.



Use Save As to save a picture for the first time or to save an existing picture with a new 
name or in a different format.

Use Save to save changes in a previously saved picture.



Before you print, use Print Setup to set up your printer.

You may also want to calibrate your printer before your print.



1 to 1 prints the picture at its current size. This option does not adjust for picture 
resolution if the resolution is different from your printer resolution.

Actual Size prints the picture at its current size and resolution.

Fit to Page resizes the picture to the page size indicated in your Print Setup dialog box.

Scale changes the printed size of the picture. Adjust the size in the Scale text box.

Poster prints across multiple pages if you scale a picture larger than your page.

Smooth Resize removes blockiness that may occur when you print a picture larger than 
its actual size. Some detail may be lost if you choose Smooth Resize.



Use PhotoFinish's to let PhotoFinish select the best pattern.

Use Printer's to use the printer's default halftone, if it has one.



The options you can change depend on your printer.



The duplicate picture appears in a new window at the same magnification as the previous
window and is added to the Window menu picture list.



The active window is placed at the top left corner of the desktop.



You can edit your picture in Full Screen mode.

You cannot edit your picture in Show Screen mode.



Select values for Red, Green, and Blue.

To fill, replace, or select a single color, set the values to 0.

Choose Identical Values to set all the ranges at the same values.

Depending on your picture, values that give good results range from about 10 to 50. A 
value of 25 is a good place to start.



VGA Palette isn't available if your screen displays 16 or more gray levels.

Read the warning in the dialog box before you complete this command.



Click to increase the number of grays you see on-screen.

Before you test your hardware, save all of your work. Your system may not support this 
option.



If color areas become gray, you can use the VGA Hardware Palette.

If the screen turns black or your system locks up, you cannot use the VGA Hardware 
Palette.



Exit Windows and start Windows again to use the new VGA setup.

The VGA setup becomes a PhotoFinish program default.

Deselect the option if you no longer want to use it.



Changes what PhotoFinish displays when you start the program.

Choose Nothing if you do not want to load a file or see the About box when you start 
PhotoFinish.



The status bar shows context-sensitive information at the bottom of your screen.



Saves thumbnail preview pictures to disk with an extension that begins with !. For 
example, a thumbnail picture of a .PCX file has a .!PX extension.



Click to change Photo Finish's virtual memory manager settings.



Choose a unit of measure for your work from the Units drop-down list.



You can open a scanner configuration to load previously saved options before you scan.



The scanned image appears in a picture window named "NEW."

Use the File Save As command to save the image to disk with a new name.



You can use any unit of measure with a video grabber.



Width cannot be wider than the width of your hand scanner.



For perfect placement, you can use the arrow keys to move the selected area one pixel 
at a time.



If Save Backup Copy is selected, PhotoFinish saves a backup copy of your picture. The 
backup file's name is the same as the original's, except the last letter of the extension is a $.

If Save Thumbnail Files is selected in the Options Preferences dialog box, thumbnails are
automatically saved for all file formats.

Thumbnail preview pictures are saved to disk with an extension that begins with an 
exclamation point. For example, a thumbnail preview of a .PCX file has the extension of .!PX.

If you cannot save a file to the disk or directory where the picture is, the thumbnail file is 
saved to a PhotoFinish subdirectory named THUMNAIL.



Double-click the Zoom tool to quickly return to 100% view.



Hue selects the color.

Amount adjusts the color's intensity.

Choose Restore to cancel changes.



Hold down Shift while you drag to constrain the tool vertically or horizontally.

Press the spacebar to change the direction of the constraint.



Hold down Shift while you drag to constrain the tool to a square.



Hold down Shift while clicking or dragging to constrain the tool vertically, horizontally, or 
at a 45° angle.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.

You can use the Airbrush with gray scale and 24 bit color pictures.

Use Convert To to change the color mode if the tool is not available.



The tools may be grouped. Press on the white triangle and drag to the tool you want to 
use.

You can use the Smear Paintbrush with gray scale and 24 bit color pictures.

Use Convert To to change the color mode if the tool is not available.



The Clone tool gives you more precise control than copying and pasting a picture.



The point where you click defines where cloning begins.

To change the source for your clone, point to another area and click the right mouse 
button.



No cloning occurs after you reach the edges of your source picture.

The first click with the clone brush sets the beginning point for painting.

Hold down Shift while you drag to constrain cloning vertically or horizontally. Press the 
spacebar to change the direction of the constraint.



Drag the square handles to reposition the ends of the curve.

Drag a circle handle to bend a portion of the curve.



You can enter more than 400 characters, or about 10 lines of text.

Press Ctrl+Enter to start a new line.

Press Ctrl+V to insert text from the Clipboard.



The text appears in your picture surrounded by the Text Frame box.

Drag the handles on the Text Frame to adjust your margins.

Point to the middle of the Text Frame and drag to move the text to another location before
you paste it.



Press the spacebar to edit your text.

Select a different secondary color from the Palette if you want to change the color of your 
text.

Use the Font More Fonts command to select another font or change font style, size, and 
effects.



To make another picture active, click the title bar of the picture you want to edit or choose
its name from the Window menu picture list.



Double-click an icon to restore the picture to your desktop or choose its name from the 
Window menu picture list.



A check mark appears beside the command to show it is selected.

PhotoFinish applies the best halftone for the picture. Using this command slows down the
program's response time.

You can make other on-screen adjustments with the Display Calibrate Monitor command 
and VGA Palette options in the Preferences dialog box.



Adjust soft brush settings for the tool.



Select a new brush shape.



Replace the primary color with the secondary color in the area you see in the active 
picture window.



Replace all colors in a picture with the background color.



Adjust color tolerance.



Quickly surround the entire picture with the marquee.



Set your tool width.



Like Edit Undo, return your picture to the look it had before you last chose a tool or 
command.



Quickly return to a one-to-one view in a zoomed picture.



Hold down Shift while you drag to constrain the tool to a circle.



Hold down Shift while defining an area with the Box Selection to define a square.

Hold down Shift while defining an area with the Scissors or Lasso to constrain 
horizontally, vertically, or at 45 degree angles.

Hold down Shift while defining an area with the Elliptical Selection to define a circle.

Hold down Shift while you drag a cutout to leave a single copy behind.

Hold down Ctrl while you drag a cutout to leave a trail of copies behind.



Key to PhotoFinish Help

Press and hold down the mouse button on an underlined down arrow for additional 
information.

Click an arrow that points to the right to jump to more in-depth information.
Point to a word with a broken underline and hold down the left mouse button to read the word's 

definition.
Click words with a solid underline to jump to information about that topic.



Information includes the name of the picture, width and height in pixels, resolution in dots 
per inch and dots per centimeter, picture type, image size, picture format and subformat, and whether the 
picture has changed since it was last saved.



Changing the picture resolution affects how PhotoFinish prints your picture in certain 
modes and can affect how circles and squares look when you draw.

If Vertical and Horizontal resolution are different, circles and squares do not look correct.



The higher the number, the more edges are enhanced.



The arrows point to the direction of the movement.



RGB adjusts the amount of red, green, and blue.

CMY adjusts the amount of cyan, magenta, and yellow.

HLS adjusts the hue, lightness, and saturation.



Click in the Color Slider bar or drag the Color Slider arrow.

You can also use the mini-scroll bar or type a number in the appropriate text box to the 
right of the slider.

Choose Restore to return to the original values.



The color you click on appears in the color sample box.

You can also drag in the Color Refiner box to select a color.



Adjusts the edges of the paint stroke. 

Hard keeps the edges of the paint stroke hard. 

Medium partially softens the edges of the paint stroke. 

Soft softens the edges of the paint stroke the most. 



Adjusts the overall softness of the paint stroke. 

The lower the number, the finer the brush strokes with smaller, softer edges. 

The higher the number, the bolder the brush strokes with less soft edges. 



Adjusts the opacity of your paint.

The higher the number, the greater the transparency.

If you are using the Charcoal tool, this option is not available. Charcoal tool transparency 
is set in the Palette. Positive numbers produce white chalk; 100 is solid white. Negative numbers produce 
black chalk; -100 is solid black. A setting of 0 has no effect.



Positive numbers produce white chalk; 100 is solid white. 

Negative numbers produce black chalk; -100 is solid black. 

A setting of 0 has no effect.



Adjusts the rate at which the brush stroke disappears. 

The higher the number, the more quickly fade out occurs.



Adjusts the distance between each stroke as you drag the tool. 

The lower the number, the closer the brush strokes. Use a setting of 1 for the smoothest 
stroke.

This option is not available for the Airbrush tool.



Adjusts how fast the paint is applied.

The higher the number, the faster the paint is applied.

This option is available for the Airbrush only.



Paints multiple copies of your clone source.

If Rubber Stamp is selected, your clone source is reset to the beginning each time you 
click the left mouse button.

This option is available for the Clone tool only.



Select this option to use PhotoFinish's virtual memory manager. Enable Virtual Memory is
recommended for standard mode.

Disabling PhotoFinish's virtual memory manager improves program performance if you 
have enough Windows memory for your pictures.



Type a number greater than 64 to specify in kilobytes the minimum amount of Windows 
memory you want to allocate to PhotoFinish.

This option is not available if you have disabled PhotoFinish's virtual memory manager.



Type a number greater than 64 to specify in kilobytes the maximum amount of Windows 
memory you want to allocate to PhotoFinish. Generally, if the number is too high, you may notice a 
decrease in program performance.

This option is not available if you have disabled PhotoFinish's virtual memory manager. 



You can assign up to four drives for PhotoFinish to use to store temporary files.

This option is unavailable if Enable Virtual Memory is not selected.

List fastest drives first.

Separate paths with a semicolon.

Network and floppy drives are not recommended.

If you are using a disk doubling program, you must set your virtual memory path to an 
"uncompressed" volume.



Changes a picture to black and white.

Choose Line Art if you do not want a halftone applied.

Choose Printer to use a fatting halftone.

Choose Screen to use a diffused halftone.

Some commands and tools cannot be used with black and white pictures.



Changes a picture to 256 color.

Some commands and tools cannot be used with 256 color pictures.



Changes a picture to gray scale.

Most commands and tools can be used with gray scale pictures.



Changes a picture to 24 bit color.

All commands and tools can be used with 24 bit color pictures.



Select a drive from the Drives drop-down list.

Select a Directory from the Directories list box.

You can also type the full path and name in the File Name text box.



RGB adjusts levels of red, green, and blue in the selected color.

HLS adjusts the hue and levels of lightness and saturation in the selected color.



If you want PhotoFinish to automatically adjust the outline, choose Auto.

If you are working with a gray scale picture, choose Light for white outlines or Dark for 
black outlines.

If you are working with a 24 bit color picture, choose Light for light colored outlines or 
Dark for dark colored outlines. 



All adjusts all the colors in the picture and is the only channel available for gray scale 
pictures.

Choose a single color channel to create special effects or to adjust color balance in your 
image. 



Smoothes distribution and fine-tunes other Styles.

Point to the handles on the curve in the sample box and drag to adjust the curve.



Allows you to draw any shape you want in the sample box.

Point to the curve and drag to draw the curve you want.



Allows you to adjust brightness and contrast of a channel.

Point to the handles on either end of the line in the sample box and drag to make 
adjustments.



To close a single copy of a picture, use the Close command on the picture's Control 
menu.



Change the numbers in the appropriate text boxes to indicate the size of the area you 
want to scan.

You can also drag a frame marker to adjust margins.

If you are using a flatbed or hand scanner, click Default to set the scan area to the current
scan size.

Click Restore to reset the scan area to the last margin settings you used.



Click to quickly prescan the picture or area so you can identify a portion to scan or 
capture.

Choose Draft or Quality mode from the Prescan drop-down list.

If you are using a video grabber, select a Single mode to prescan the area once or select 
a Multiple mode to continuously prescan the area.



Drag the arrows to adjust Brightness and Contrast while you continuously prescan an 
area.

You can also adjust Brightness and Contrast in the scanning Options dialog box.



Click to display the progress of the scan as you move the hand scanner.



The image appears in the Scan Area box when you prescan.

Point to a frame marker and drag to adjust the size of the final scan.

Drag the frame to change the location of the final scan.



The image you scan appears in the box.

Click OK and the image is loaded into a picture window.



Click to specify the size of the area to be scanned or captured.



The Eraser changes parts of your picture to the background color.



With a hand scanner, you should scan from top to bottom.

You can also open a picture and then use the Scan Stitch command.



Click available Enhancements options to change your picture during scanning.

Border Erase adds a white border.

Edge Enhance increases definition between dark and light areas. 

Gamma Correct gives an appearance of greater contrast and shows more gray shades.

Line Art Detect preserves black and white areas and uses a halftone pattern on multicolor
areas.

Mirror Image flips the image.

Negative Image reverses the colors.

Outline traces the edges of objects.



Select a resolution setting from the Resolution drop-down list.

If Custom Resolution is available, choose it to individually set the horizontal resolution 
(Horiz) and vertical resolution (Vert) in the appropriate text boxes.



Select a halftone setting from the Halftone drop-down list if your picture has more colors 
than your scanner supports.

These are the halftone patterns that might be available depending on your scanner:

    None

    Bayer

    Coarse Fatting

    Error Diffusion

    Fine Fatting

    Horizontal Line

    Vertical Line

    Vertical Line

    Mesh

    Scanner Defined 1 and 2



Drag the slider box or type a number to adjust the size of the scanned image if your 
scanner supports variable resolutions. 

Increasing or decreasing scaling may change the look of the image.

Click 100% if it is available to quickly adjust scaling to 100%.



Select a color mode and number of colors for the scan from the Image Type drop-down 
list.

PhotoFinish supports color, gray scale, and black and white.

Only the image types your scanner supports are available.



Chrominance can be set from -8 to 100.

The larger the number, the more definition between colors is lost.

If your picture is made up of similar colors, you can use a slightly larger number with 
acceptable results.



It is highly recommended that you check the compression results before you discard the 
original picture.

To check the results of saving, you must open the compressed picture again and 
compare it to the original.



The greater the loss, the smaller the file size, but the more detail is lost from your picture.
The amount of loss that occurs each time you save the picture again, with the same settings, depends on 
how much you change the picture.



The first number represents how many pixels to look at for the Chrominance setting.

The second and third numbers represent two color channels. They determine how may 
pixels to view as a single value.

The larger the subsample, the less detail is lost.



Luminance can be set from -8 to 100.

The larger the number, the more definition between colors is lost.

If your picture is low contrast, you can use a slightly higher setting with acceptable 
results.



Use the mini-scroll bar or type a number from 0 to 255 in the Noise text box.

Choose Flat or Bell Curve from the Distribution drop-down list.

Flat shows more pronounced changes than Bell Curve.

Choose the color channel you want to affect.



You can use textures PhotoFinish automatically copied to a subdirectory named 
TEXTURES when you installed the program.

You can also use any gray scale picture as a texture.



You can resize defined areas freehand with the Transform Free Resize command.

You can specify the amount to resize pictures or defined areas with the Transform Resize
command.



You can keep the dialog box displayed and use the tool so you can quickly experiment 
with different settings.

Choose Undo Picture to cancel changes to your picture.

Choose Restore Settings to return the settings to their original values. Cancel becomes 
available to close the dialog box.

Choose Close to close the dialog box and use the new settings.



Adjust the Pick Up Area for the Eyedropper tool.



Select the number of sides for the polygon.



Set the spacing between the tiles by choosing a tool width.



PhotoFinish selects an appropriate halftone pattern if you use an average option with a 
black and white picture.



Hold down Shift while you drag to keep the polygon pointing upward.



A regular polygon can have from 3 to 10 sides.



PhotoFinish prints the CALIBRTE.PCX picture.



PhotoFinish scans the picture and builds a printer map to compensate for the difference 
between the scanned picture's response curve and the correct response curve.



Choose Transparent if you want the areas in the tile pattern that are the primary color to 
be transparent. The colors already in the picture show through the tile pattern.

Choose Opaque if you want the areas in the tile pattern that are in the primary color to 
show. The entire tile pattern covers the colors already in the picture.



24 bit color is available only if your scanner supports 24 bit color scanning.

If your scanner does not support either 24 bit color or gray scale scanning, recalibration is
unavailable.



If your printer supports color and you want to print in color, choose 24 Bit Color.

If you want to print in gray scale or black and white, choose 256 Gray Scale.



If you are opening a texture, it must be gray scale or 24 bit color.

Use Image Convert To to convert the picture to gray scale to use it as a texture.



The check marks next to the different workboxes in the Screen Layout cascading menu 
disappear to indicate that all the workboxes have been removed.



Check marks appear next to the workboxes in the Screen Layout cascading menu to 
indicate that all the workboxes are displayed.



The menu bar disappears to give you more on-screen viewing room.

Press Ctrl+F to return to normal view.



Select a drive from the Drives drop-down list.

Select a Directory from the Directories list box.

Select another format from the List Files of Type drop-down list.



Select a drive from the Drives drop-down list.

Select a Directory from the Directories list box.



Select a drive from the Drives drop-down list.

Select a Directory from the Directories list box.

You can also type the full path and name in the File Name text box.

Save your response curves in the MAPS subdirectory if you want PhotoFinish to 
automatically display then in the Preset Maps drop-down list.



The cross hair is attached to the selected tool with a vertical and horizontal running from 
the center of the cursor.

The cross hair is available for all tools except the Eyedropper, Hand, Zoom, Locator, 
Paint Roller, Tile Pattern Paint Roller, and Gradient Paint Roller tools.



The cutout can be either a defined area or another picture you selected with the Edit 
Paste or Edit Paste From command.



Choose the color in the cutout that you want to be pasted transparently as the 
background color.



Adjust the tool width to set the distance between the tile patterns. The higher the number,
the greater the distance between the tile patterns.



You cannot delete a preset map.

To edit a preset map, you must first choose New to create a new map based on the 
preset map. Then choose Edit to make your changes.



Drag an arrow or type a number to adjust brightness and contrast.

If Auto is available, select it to have your scanner automatically set a level. An X appears 
in the check box next to the option to show that it is selected.

For a video grabber, you can also adjust brightness and contrast in the Select Video Scan
Area dialog box when you prescan.



Click to begin scanning or capturing the area.



Click to adjust some of the settings supported by your scanner or video grabber.



The available command is the opposite of your current Toolbox format.

An ungrouped Toolbox shows all of the tools and is larger than a grouped Toolbox.

A grouped Toolbox arranges similar tools together so your Toolbox is smaller.



The number of columns or rows changes, and the Toolbox remains grouped or 
ungrouped.



The available command is the opposite of your current Palette layout.



If you are working with a 256 color or black and white picture, the Rubber Stamp option is
the only option used.



Standard US letter size, 8.50 x 11.00 inches.



Standard US legal size, 8.50 x 14.00 inches.



The size you type in the Horizontal Size and Vertical Size text boxes.



Standard US size, 11.00 x 17.00 inches.



Standard European size, 29.70 x 42.00 centimeters.



Standard European size, 21.00 x 29.70 centimeters.



Standard European size, 14.80 x 21.00 centimeters.



Standard European size, 17.60 x 24.00 centimeters.



A check mark appears indicating that the option has been selected.



The check mark disappears indicating that the option has been deselected.



PhotoFinish supports all installed Windows fonts.



When the Select a Brush Style dialog box appears, select a shape and click OK.



Choose Cancel to return to the work area.



    Box Selection, Magic Wand, Lasso, Scissors, Elliptical Selection



    Line, Curve, Tile Pattern Line



    Paint Roller, Gradient Paint Roller, Tile Pattern Paint Roller



    Hollow Box, Hollow Rounded Box, Hollow Ellipse/Circle, Hollow Regular Polygon, Hollow 
Polygon



    Filled Box, Filled Rounded Box, Filled Circle/Ellipse, Filled Regular Polygon, Filled Polygon



    Smear Paintbrush, Smudge Spraycan



    Airbrush, Spraycan



You can use this command with all paintbrush tools and the Airbrush, Charcoal, Clone, 
Color Replacer, Eraser, Fountain Pen, Line, and Local Undo tools.



The farther the number is from 0, the greater the effect.



You can use this command with 256 color and 24 bit color pictures.

Use Convert To to change the color mode if this command is not available.



The settings you adjust affect only the selected tool so you can alternate between soft 
tools without having to change settings.



Think of hue values as degrees on a color wheel. For example, red is 0 degrees (red is 
also 360 degrees) and green is 120 degrees.

If you type 60, you shift all colors 60 degrees: red colors become yellow, yellow colors 
become green, etc.

180 degrees reverses the colors in your picture.



Keep in mind that choosing this option requires more time.



You can view up to 12 sample pictures, or thumbnails.

If there are more pictures in the current drive, directory, and selected format than are 
displayed, you can use the scroll bar to display additional thumbnails.



You can also double-click the picture to open it.



A check mark appears beside the command to show it is selected.



Hold down Shift while you drag to proportionally adjust the picture.



Choose OK to abandon all changes.

Choose Cancel to continue working on your picture.



PhotoFinish displays the type of enhancement that is being applied and the progress of 
the enhancements in the Progress box.

It is a good idea to clean off your scanner's glass before scanning.

If you are scanning an object that is smaller than the scanner's glass, place paper around
the object to be scanned to cover the glass. This will improve the quality of your image.



PhotoFinish displays the type of enhancement that is being applied and the progress of 
the enhancements in the Progress box.



Choose Cancel to cancel the changes.



The higher the number, the greater the effect.



You can choose 90, 180, 270 degrees or you can specify a custom rotation.



Select Proportional Resize to have PhotoFinish automatically adjust your picture 
proportionally.



The larger the tile size, the more time is required for the special effect to work.



Select All selects the entire picture and surrounds it with the marquee.

You can also select the entire picture by double-clicking any selection tool except the 
Magic Wand.



Select a preset level to determine the effect of the command.

Light is the least amount of effect, and Heavy is the most.

Choose Custom to customize the effect.



The selected area appears in a new picture window.



Type the new name for the selected picture in the File Name text box.

Choose OK to rename the file.



Select None is a handy way to start the selection process again if you make a mistake.



A copy of the cutout remains behind.

You can release the mouse button and then drag again to place your cutout exactly 
where you want it.

You can also use the arrow keys to move a cutout one pixel at a time.



A trail of copies appears where you drag the cutout.

Release the mouse button when you are finished dragging the cutout.

You can also use the arrow keys to move a cutout one pixel at a time.



Cutouts are pasted opaquely until you select the command again.



PhotoFinish displays preset maps, created for the device type, saved in the subdirectory 
named MAPS.



You can specify any number from -1 to 1 in the Saturation text box.

Negative numbers decrease saturation by adding gray.



Select a preset level to determine the effect of the command.

Small is the least amount of effect, and Large is the most.

Choose Custom to customize the effect.



If you have a 24 bit color picture, you can choose Allow Color Shift to introduce new 
colors into the picture.



The selected background color is the color that will be used for clearing.



All adjusts all the colors in the picture and is the only channel available for gray scale.

If you are working with a color picture, choose a single color channel to adjust for color 
balance problems.



The Scan dialog box appears.



The second image is added to the active picture and is surrounded by the marquee.



Picture information is displayed in the status bar at the bottom of the dialog box.

You can also select multiple pictures.



The selected files appear as thumbnails.



The Progress box indicates completion of each step of the calibration process.



PhotoFinish automatically saves the file in the PhotoFinish subdirectory named MAPS 
and adds it to the Preset Maps list.



The font is selected and the typeface name appears on the list followed by the selected 
point size and font style.



You can choose to shade vertically, horizontally, or radially.



If you make mistake, click Restore to return to the original colors in your Palette.



Choose Cancel to undo all color changes you have made and return to the main 
PhotoFinish screen.



Keep in mind that if you are working with a 24 bit color picture, the color changes do not 
affect the picture. You are simply changing the colors displayed in your color set and Preview is not 
available.



Palette color sets have a .PAL extension.



You can also double-click the Regular Polygon tool to set the number of sides.



An X appears in the check box to indicate the option is selected.



Bilevel sets the image or selected area to black and white.

4 Levels sets the image or selected area to 4 colors.

10 Levels sets the image or selected area to 10 colors.

Choose Custom to customize the effect.



Keep in mind that reducing colors can create a "flattened" effect in your picture.



This effect is available for 24 bit images only.



For best results, you should calibrate your scanner, then your printer, and finally your 
monitor.



Select the option that applies most to the object you are scanning.

You can choose Auto to let PhotoFinish automatically set the color format.

Choose B/W Photo for a gray scale scan.

Choose Text/Line Art for a black and white scan of text and line art -- gray areas are 
composed of black and white dots.

Choose Color Photo for a color scan. If your scanner does not support 24 bit color, 
PhotoFinish automatically converts the picture to 24 bit color before applying the corrections.



An X appears in the check box to indicate the option is selected.

Saturation is not applied to black and white line art and gray scale scans.



If you plan to use the picture for on-screen viewing, choose a Screen option.

If you plan to print the picture, choose one of the printer selections.

The printer resolution PhotoFinish uses depends on the Image Type you select.



The values you should specify depend on the output device for your image. Use the 
following general guidelines to help you determine the appropriate resolution.

If you are specifying resolutions for an ordinary printer, the resolution for Text/Line Art 
generally should match your printer's resolution. The resolution for Photo can be about 1/3 of your 
printer's resolution, depending on the halftones available to your printer.

If you are specifying resolutions for a "high-end" printer such as a film recorder, the 
resolutions for both Text/Line Art and Photo should match the printer's resolution.

If you are specifying resolutions for on-screen viewing, both Text/Line Art and Photo 
settings should match your screen's resolution.



If you want to save your settings with a new name, type a description for your settings in 
the text box and choose Add.

If you want to delete the current Output selection, choose Delete.



You can also click the arrow to fold and unfold the Palette.



The check mark disappears indicating that the command is deselected.



A check mark appears indicating that the command is selected.



The dialog box expands to display the additional options.



The higher the number, the greater the effect.

Select Wide Aperture to create a sharper effect.

Keep in mind that selecting this option requires more time.



The higher the number, the greater the effect.

Select Wide Aperture to create a smoother effect.

Keep in mind that selecting this option requires more time.



Selecting a TWAIN Source

To select a TWAIN source:    

1 Choose the Select Source command on the File menu.    

2 Click the source you want to use.    

Related Topics:
Acquiring an Image with a TWAIN Device
Scanning a Picture



Acquiring an Image with a TWAIN Device

To scan with a TWAIN device:    

1 Select the source you want to use.    

2 Select the Acquire command on the File menu.    

Related Topics:
Scanning a Picture
Selecting a TWAIN Source



Use the Select Source command on the File menu to select your source.

This command appears only if your scanner or video grabber supports the TWAIN 
standard interface.

If you installed your scanner for PhotoFinish, you can also use the Scan Scan command 
on the File menu to scan or capture an area.



Use the Acquire command on the File menu to scan or capture the area you want.



This command appears only if your scanner or video grabber supports the TWAIN 
standard interface.

The dialog box that appears when you choose Acquire differs depending on the brand of 
your scanner or video grabber.

The scanned image is loaded into a new picture window in PhotoFinish.

If you installed your scanner for PhotoFinish, you can also use the Scan command on the
Scan menu to scan or capture an area.



TWAIN
TWAIN is a standard interface that allows applications to acquire images from many different sources. The source may be a 
scanner, video capture board, or other input device that complies with the TWAIN specification. If you want to use PhotoFinish's 
scanning capabilities, install your scanner with the PhotoFinish setup program.



Working with Embedded Pictures

You can use PhotoFinish to embed or link pictures in other applications that support Object Linking and 
Embedding (OLE).

If you link a PhotoFinish picture, your source picture is in a file that is separate from the 
destination file. You can open the picture in PhotoFinish, make changes and save it using the File Save 
command, and the destination application will automatically update the linked picture.

If you embed a PhotoFinish picture, your picture becomes part of the destination file. You 
can make changes to the picture only by opening the destination file and choosing the embedded picture. 
Double-clicking on the embedded picture automatically opens PhotoFinish with the embedded picture 
loaded in a picture window. If only a portion of the original picture file is embedded, the entire picture 
appears and the embedded portion is surrounded by a box. You use the File Update command to update 
your changes in the destination file.

If you are working with an embedded PhotoFinish picture, several of the commands in 
the File menu change. Save becomes Update, Save As becomes Save Copy As, and Exit becomes Exit 
and Return To.



File Update Command -- Updating an Embedded Picture

You use the Update command to update the destination file's version of the picture without exiting 
PhotoFinish. 

To update an embedded picture:

Choose Update from the File menu.    

Related Topics:
Saving a Copy of an Embedded Picture
Saving a Picture with Save
Working with Embedded Pictures



File Save Copy As -- Saving a Copy of an Embedded Picture

You use the Save Copy As command to save a copy of an embedded picture to a file on disk. This 
command is similar to the Save As command.

To save a copy of an embedded picture:

Choose Save Copy As from the File menu.    

Related Topics
Updating an Embedded Picture
Working with Embedded Pictures



File Exit and Return To Command -- Exiting and Returning to the Destination 
Application

You use the Exit and Return To command to end your PhotoFinish session and return to the destination 
file. 

To exit and return to your destination application:

Choose Exit and Return To from the File menu.    

Related Topics:
Exiting PhotoFinish
Working with Embedded Pictures



embedded object
Information that is created in a server application and inserted into a client application. You can edit the information from within the 
client file.

PhotoFinish is a server, or source, application. You can create a picture in PhotoFinish and embed the picture in a client, or 
destination, application, such as Windows 3.1 Write.



linked object
A placeholder for information that is inserted into a client file. The information still exists in the server file. When the server file is 
changed, the linked object is updated to reflect these changes.

PhotoFinish is a server, or source, application. You can create a picture in PhotoFinish and link the picture in a client or destination 
application, such as Windows 3.1 Write.



Updating does not save the picture as a separate file. 

Use Save Copy As to save a copy of the PhotoFinish picture to disk.

You can also use the destination application's File Save command to save the updated 
picture as a part of the destination file.



The Save Copy As command does not update the embedded picture in the destination 
file -- you use Update to update an embedded picture.

Keep in mind that unless you save the picture to disk using the Save Copy As command, 
you cannot load it except by choosing the embedded picture in the destination file.



If you have made changes to a picture since the last time you updated it, a message box 
appears asking if you want to save the changes before you exit PhotoFinish. 

Choose Yes to update the embedded picture in the destination file. 

Choose No if you want to exit without making any changes to the embedded picture. 

Choose Cancel if you want to continue to work on the picture.



If you select File Open while working with an embedded picture, PhotoFinish loads the 
picture into a separate picture window that does not affect the embedded picture.



If you are working with an embedded picture, the File Exit and Return To command 
replaces the File Exit command. 


